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Disclaimer 

This Software Manual has been developed for use with the referenced Software. Use of the Software, 
and use of this Software Manual are governed by a License Agreement. Among other provisions, the 
License Agreement sets certain warranties for the Software and this Manual, disclaims other warranties, 
limits recoverable damages, defines permitted uses of the Software, and determines whether you are an 
authorized user of the Software. All information set forth in this manual is provided with the warranty set 
forth in the License Agreement. Please refer to the License Agreement for important obligations and 
applicable limitations and restrictions on your rights. Trimble does not guarantee that the text is free of 
technical inaccuracies or typographical errors. Trimble reserves the right to make changes and additions 
to this manual due to changes in the software or otherwise. 
 
In addition, this Software Manual is protected by copyright law and by international treaties. 
Unauthorized reproduction, display, modification, or distribution of this Manual, or any portion of it, may 
result in severe civil and criminal penalties, and will be prosecuted to the full extent permitted by law. 
 
Tekla, Tekla Structures, Tekla BIMsight, BIMsight, Tekla Civil, Tedds, Solve, Fastrak and Orion and are 
either registered trademarks or trademarks of Trimble Solutions Corporation in the European Union, the 
United States, and/or other countries. More about Trimble Solutions trademarks: 
http://www.tekla.com/tekla- trademarks. Trimble is a registered trademark or trademark of Trimble 
Navigation Limited in the European Union, in the United States and/or other countries. More about 
Trimble trademarks: http://www.trimble.com/trademarks.aspx. Other product and company names 
mentioned in this Manual are or may be trademarks of their respective owners. By referring to a third 
party product or brand, Trimble does not intend to suggest an affiliation with or endorsement by such 
third party and disclaims any such affiliation or endorsement, except where otherwise expressly stated. 
 
Portions of this software: 
D-Cubed 2D DCM © 2010 Siemens Industry Software Limited. All rights reserved. 
EPM toolkit © 1995-2004 EPM Technology a.s., Oslo, Norway. All rights reserved. 
Open CASCADE Technology © 2001-2014 Open CASCADE SA. All rights reserved. 
FLY SDK - CAD SDK © 2012 VisualIntegrity™. All rights reserved. 
Teigha © 2003-2014 Open Design Alliance. All rights reserved. 
PolyBoolean C++ Library © 2001-2012 Complex A5 Co. Ltd. All rights reserved. 
FlexNet Copyright © 2014 Flexera Software LLC. All Rights Reserved. 
This product contains proprietary and confidential technology, information and creative 
works owned by Flexera Software LLC and its licensors, if any. Any use, copying, publication, 
distribution, display, modification, or transmission of such technology in whole or in part in any form or by 
any means without the prior express written permission of Flexera Software LLC is strictly prohibited. 
Except where expressly provided by Flexera Software LLC in writing, possession of this technology shall 
not be construed to confer any license or rights under any Flexera Software LLC intellectual property 
rights, whether by estoppel, implication, or otherwise. 
 
To see all the third party licenses, go to Tekla Structures, click Help --> About and click the Third party 
licenses button. 
 
The elements of the software described in this Manual are protected by several patents and possibly 
pending patent applications in the United Stated and/or other countries. For more information go to page 
http://www.tekla.com/tekla-patents. 
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1 Introduction 

These guidance notes have been developed to give practical advice to users of Autodesk Revit wishing 
to integrate models between Autodesk Revit and our own Tekla Structural Designer software. 
 
These notes are not intended to replace our existing Guidance Documentation notes, which are 
installed as part of the Tekla Structural Designer Integrator for Autodesk Revit application, and users are 
strongly recommended to read these notes in addition to this document. 
 
This document largely deals with the subjects of model connectivity and object mapping as these are the 
most important considerations when building models within Autodesk Revit. 
Several sections relating to important information and advanced subjects are also contained. 
 
It may be noted that several appendices deal with the setting up of Revit tags and schedules. These are 
included for information use only and may be omitted if users own templates contains alternative 
information. 
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2 Important Information 

2.1 The Use and Importance of GUID references 

The integration between Tekla Structural Designer and Autodesk Revit software is enabled by the use of 
GUID (Global Unique IDentifiers) references.  

 
A GUID is a unique number that can be used as an identifier but should not be able to be replicated - 
with randomly generated GUIDs you should only be duplicating references once every 10-30 trillion 
GUIDs. 

 
GUID references themselves are a 32 digit hexadecimal reference and are created by a complex 
algorithm, with the references written as part of a members properties within the CXL file. We track 
members based on the GUID reference rather than member size, position, Revit element ID or any other 
method. 

 
The GUID reference itself is automatically created by Tekla Structural Designer when an object is first 
inserted into the model. This happens 'behind the scenes' of the program interface and the user is never 
directly aware of the references. 
 

 
 
Please note however, that Revit by default does not use GUID references. Revit instead uses Element 
ID references, which can be easily duplicated within differing models. 
To avoid any sort of duplication issues, the integration process will assign GUID references to all object 
instances when models are either imported into Revit or exported from Revit.  
 
Please note that these references will be lost on exiting from Revit unless the model is saved first. 
It is therefore vital that the Revit model is saved after performing an export to Tekla Structural 
Designer. 
Failure to save will lose the GUID references on exiting the program and remove the ability to 
communicate any model changes with Tekla Structural Designer. 

 

2.2 API - Application Program Interface 

An API (Application Program Interface) controls the transfer between Tekla Structural Designer and 
Autodesk Revit. The API is a separate program that sits inside the Tekla Structural Designer Integrator 
for Autodesk Revit application, and is provided by Autodesk for the Trimble Solutions product 
development team to use. 
 
The API is the governing factor between the two items of software and controls which object can be 
passed to and from the software packages. It can also limit what sort of change control can be 
performed with each category. 

 For example, Floor category instances can be created or deleted using the API, but they cannot 
be updated in boundary shape. Therefore, if a floor instance changes boundary shape, the 
integrator is forced to delete the existing floor instance and create a new instance in its place. 



2 Important Information 9 (230) 

 

Guidance Notes Autodesk Revit Guidance 
© Trimble Solutions Corporation | December 5, 2019 Tekla Structural Designer Integrator 

 

 

2.3 Parameters Transferred 

Tekla Structural Designer will transfer the following parameters into Revit:- 
 

Analysis Result Parameters 

Parameter Name Description  Notes  

Result_AxialMax  Maximum Axial Force Applicable to Structural Framing Bracing members only 
when analysis results imported 

Result_ColMajorMomentMax  Maximum Moment in Major 
Axis 

Populated by Steel Structural Column Members when 
analysis results imported 

Result_ColMajorMomentMin  Minimum Moment in Major 
Axis 

Populated by Steel Structural Column Members when 
analysis results imported 

Result_ColMajorShearMax  Maximum Shear in Major Axis Populated by Steel Structural Column Members when 
analysis results imported 

Result_ColMajorShearMin  Minimum Shear in Major Axis Populated by Steel Structural Column Members when 
analysis results imported 

Result_ColMinorMomentMax  Maximum Moment in Minor 
Axis 

Populated by Steel Structural Column Members when 
analysis results imported 

Result_ColMinorMomentMin Minimum Moment in Minor 
Axis 

Populated by Steel Structural Column Members when 
analysis results imported 

Result_ColMinorShearMax  Maximum Shear in Minor Axis Populated by Steel Structural Column Members when 
analysis results imported 

Result_ColMinorShearMin  Minimum Shear in Minor Axis Populated by Steel Structural Column Members when 
analysis results imported 

Result_ColVShearMax  Maximum Vertical Shear Populated by Steel Structural Column Members when 
analysis results imported 

Result_ColVShearMin  Minimum Vertical Shear Populated by Steel Structural Column Members when 
analysis results imported 

Result_EndAxialMax  Maximum Positive Axial on 
Beam End 

Populated by Steel Structural Framing Beam members 
without pinned ends when analysis results imported 

Result_EndAxialMaxNeg  Maximum Negative Axial on 
Beam End 

Populated by Steel Structural Framing Beam members 
without pinned ends when analysis results imported 

Result_EndMomentMax  Maximum Positive Moment 
on Beam End 

Populated by Steel Structural Framing Beam members 
without pinned ends when analysis results imported 

Result_EndMomentMaxNeg  Maximum Negative Moment 
on Beam End 

Populated by Steel Structural Framing Beam members 
without pinned ends when analysis results imported 

Result_EndVShearMax  Maximum Positive Shear on 
Beam End 

Populated by Steel Structural Framing Beam members 
when analysis results imported 

Result_EndVShearMaxNeg  Maximum Negative Shear on 
Beam End 

Populated by Steel Structural Framing Beam members 
without pinned ends when analysis results imported 
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Result_StartAxialMax  Maximum Positive Axial on 
Beam Start 

Populated by Steel Structural Framing Beam members 
without pinned ends when analysis results imported 

Result_StartAxialMaxNeg  Maximum Negative Axial on 
Beam Start 

Populated by Steel Structural Framing Beam members 
without pinned ends when analysis results imported 

Result_StartMomentMax  Maximum Positive Moment 
on Beam Start  

Populated by Steel Structural Framing Beam members 
without pinned ends when analysis results imported 

Result_StartMomentMaxNeg  Maximum Negative Moment 
on Beam Start 

Populated by Steel Structural Framing Beam members 
without pinned ends when analysis results imported 

Result_StartVShearMax  Maximum Positive Shear on 
Beam Start 

Populated by Steel Structural Framing Beam members 
when analysis results imported 

Result_StartVShearMaxNeg  Maximum Negative Shear on 
Beam Start 

Populated by Steel Structural Framing Beam members 
without pinned ends when analysis results imported 

 

 

Reinforced Concrete Specific Parameters 

Parameter Name Description  Notes  

TSDI_RC_Bars  Designed rebar requirement in 
column 

Populated by Concrete Structural Column objects 

TSDI_RC_Bottom  Designed rebar requirement in 
bottom of beam 

Populated by Concrete Structural Framing objects only 

TSDI_RC_Cover  Designed rebar cover 
requirement 

Populated by Concrete Structural Column and Structural 
Framing objects 

TSDI_RC_Links  Designed rebar link 
requirement 

Populated by Concrete Structural Column and Structural 
Framing objects - TSD English UK language 

TSDI_RC_Side  Designed rebar requirement in 
side of beam 

Populated by Concrete Structural Framing objects only 

TSDI_RC_Span_Links  Designed rebar link 
requirement  

Populated by Concrete Structural Framing objects only if option 
'Separate Support and Span Regions' has been enabled 

TSDI_RC_Span_Stirrups  Designed rebar stirrup 
requirement  

Populated by Concrete Structural Framing objects only if option 
'Separate Support and Span Regions' has been enabled 

TSDI_RC_Stirrups  Designed rebar stirrup 
requirement 

Populated by Concrete Structural Column and Structural 
Framing objects - TSD English US language 

TSDI_RC_Supp_Links  Designed rebar link 
requirement 

Populated by Concrete Structural Framing objects only if option 
'Separate Support and Span Regions' has been enabled. 

TSDI_RC_Supp_Region  Description of the Support 
Region extents 

Populated by Concrete Structural Framing objects only if option 
'Separate Support and Span Regions' has been enabled. 

TSDI_RC_Supp_Stirrups  Designed rebar stirrup 
requirement 

Populated by Concrete Structural Framing objects only if option 
'Separate Support and Span Regions' has been enabled. 

TSDI_RC_Top  Designed rebar requirement in 
top of beam 

Populated by Concrete Structural Framing objects only 
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General Parameters 

Parameter Name Description  Notes  

TSDI_Alias  Alias information Blank parameter left for users own use 

TSDI_Concrete_Fill  Is the member concrete filled? Populated when concrete filled hollow section columns are 
integrated - Yes/No answer 

TSDI_Design_Grp  Design Group assigned in TSD Populated by all objects when used in TSD 

TSDI_Detail_Grp  Detail Group assigned in TSD Populated by Concrete Structural Framing and Structural 
Column members 

TSDI_Dim  Steel decking profile gauge Populated by Floor objects only 

TSDI_EndConn  Connection type on end of 
member 

Populated by Structural Framing and Structural Column 
members 

TSDI_Fibre_Reinf  Fibre reinforcement details Populated by Floor objects only 

TSDI_Integration_Status  Integration Status of Object Populated by all objects - New / Updated / Unchanged 
settings available 

TSDI_Manufacturer  Steel decking manufacturer Populated by Floor objects only 

TSDI_Matl  Material grade assigned in TSD Populated by all objects 

TSDI_Not_Converted  Indicates any mapping problems Populated by Structural Framing and Structural Column 
members 

TSDI_Note  Applicable notes Populated if UDA for Note is used 

TSDI_Part_Mark  Part mark assigned in TSD Populated by all objects 

TSDI_Reference  Steel decking profile name Populated by Floor objects only 

TSDI_Size  Numerical decking data for US 
Slabs 

Was populated by Floor objects only but is no longer used 

TSDI_StartConn  Connection type on start of 
member 

Populated by Structural Framing and Structural Column 
members 

TSDI_Trans_Reinf  Transverse Reinforcement 
Requirements 

Populated by compositely designed Structural Framing 
objects only 

TSDI_Type  Member, Slab or Wall Type in 
TSD 

Populated by all objects 
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3 Revit Connectivity and Integration with Tekla 
Structural Designer 

The subject of model connectivity - or lack of it - is one of the major reasons for integration failure. 
Revit models MUST be analytically connected for a successful analysis and design of the structure to 
take place. 

 
Please note that the export from the Revit platform uses the analytical wire location for positions of all 
elements transferred into Tekla Structural Designer. 

 
The default analysis wire position can be controlled through the analytical alignment settings and this will 
be discussed in a later section. 

 

3.1 Validation inside Tekla Structural Designer 

For import processes into Tekla Structural Designer, it is important to validate the model as soon as the 
import has been completed. Validation can also be used to remove potential problems from integration. 
 

 
 
The purpose of validation is to trap errors within the Tekla Structural Designer model that will cause the 
Solver to fail.  Examples of validation errors include Unsupported Elements and Element Collision. 
 
Example of a validation warning regarding unsupported members 
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 Example of a validation error regarding element collision. 
 

 
 
Within Tekla Structural Designer, you are able to double click on the error messages in the status tree 
and find that the program will zoom and highlight the affected elements. 
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3.2 Additional visual checks within Tekla Structural Designer 

When importing a model into Tekla Structural Designer, please note that pinned supports will be 
generated under all columns where no supporting member can be detected. 

 
Check the imported model for any support elements located at unexpected positions (e.g. in the 
following image additional supports are located at splice positions). This is usually an indication of an 
underlying connectivity issue. 

 
 

 
 
 

3.3 Correcting models inside Tekla Structural Designer 

It is possible to correct validation and connectivity issues within Tekla Structural Designer. However, 
please note that Revit contains tools that allow models to be corrected more quickly than Tekla 
Structural Designer.  
Editing should ideally be performed in the Revit software as the BIM model should be considered as the 
‘master’ model concerning dimensional accuracy and set out locations. 
 
As a quick rule of thumb, we would say that if a model contains more than a dozen connectivity issues 
then it is faster to correct the model inside Revit and re-export. 
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Connectivity issues in Tekla Structural Designer can be adjusted in the Structural View by selecting the 
object (member), clicking the end node and then clicking on the correct location. 
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3.4 Creating analytically connected models within Revit 

It is important to understand that there are a number of locations that can be used for the position of the 
analysis wire, and that the location can be defined at both the start and end of the member. 
 
The analytical settings of an object can be accessed by altering the Properties Filter to use the Analytical 
Model settings. The Analytical Alignment settings should now be visible. 
 

 
 
The analytical alignment can be set to follow: 

3.4.1 Auto-Detect 

This should use the location line as a default but care should be taken as Revit can detect adjacent 
objects and move, lengthen or shorten the analysis wire to suit. 
 
The Auto-Detect option is the default option set when generating Structural Framing members. We 
would recommend that users review the analysis wire location for all members using Auto-Detect 
settings and correct where necessary. 
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3.4.2 Location line 

The analysis wire will follow the positions selected for the start and end points. In the example below, the 
beam has been defined between the grid/level intersections and so the analysis wire follows these points 
- regardless of the location of the physical object. 

 

 
 
 

3.4.3 Top of Element 

The analysis wire follows the top of the physical location, regardless of the positions selected when 
defining the object. 

 

 
 

3.4.4 Center of Element 

The analysis wire follows the center of the physical location, regardless of the positions selected when 
defining the object. 
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3.4.5 Bottom of Element 

The analysis wire follows the bottom of the physical location, regardless of the positions selected when 
defining the object. 

 

 
 

3.4.6 Additional locations 

The analysis wire can also be set to follow predefined gridlines, levels or workplanes. 
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3.4.7 Adjusting the analysis wire location for Structural Columns 

Horizontal locations 

We would recommend that Structural Column instances be moved into the correct physical location in 
plan views. The analysis wire can then be adjusted to a suitable position (such as a grid intersection 
position). 
The settings at both the top and bottom of the instance should be identical to avoid generating a sloping 
analysis wire. 
 

 
 

Vertical locations 

In a similar fashion, both the top and bottom locations of Structural Column analysis wires can be 
stipulated. Locations can include specific levels or the top and bottom of the physical representation. 
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3.5 Building Connected Models 

Using the At Grids (Structural Columns) and On Grids options when initially creating Revit models will 
help generate correctly connected analytical models. We would recommend the use of Location Line 
analytical settings when using these commands. 
 
Please note that At Grid Intersection is an option relating to the placement of Structural Columns, On 
Grid Lines is an option relating to the placement of Structural Framing objects. 
 

 
 

3.6 Snaps 

The use of snap shortcuts are also useful tools to generate connected models. 
 

 
 
Popular snaps to use when initially constructing the Revit model are: 
Recommended Snaps are- 

 SE :  Snap to Endpoint 
 SM :  Snap to Midpoint 
 SI :  Snap to intersection 
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3.7 Generating Concrete models inside Autodesk Revit 

3.7.1 Guidance for Concrete Columns 

Within the Autodesk Revit software, concrete columns can be modelled either from level to level or for 
the full height of the structure. 

Where slabs are required at slightly different heights in different wings of a building, it may simplify the 
model to use fewer levels in Revit and use vertical offsets to obtain the correct physical locations of the 
columns. 

However, if the physical length of the column is shorter than the analytical length, then the design may 
be conservative. (See lower column) 
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If the physical length of the column is longer than the analytical length, then the design may be un-
conservative. 

  

It is also possible to create columns where the analysis wires overlap if the wrong settings are used in 
Revit 

  

The analytical links option does not have any effect on Tekla Structural Designer integration. Rigid link 
elements to provide the necessary support are automatically generated on import from any concrete 
column members. 
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3.7.2 Guidance for Concrete Beams 

Beams should generally be created in Revit from reference point to reference point with levels used for 
analytical wire locations. 

 

Beams need to be defined as the full depth of the beam section, not simply the depth remaining under 
the slab. This ensures that the correct depth will be used for the design of the beam and the correct 
rebar allocation will be assigned. 
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Beam flange widths can be determined automatically within Tekla Structural Designer so artificial beam 
flanges do not need to be modelled within Autodesk Revit. See the options held in the Beam Properties 
→ Design Control → Control Flanges dialogs within Tekla Structural Designer after integration has 
taken place. 
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3.7.3 Specific rules for slab connectivity 

Floor outlines 

Please note that by default, floors modelled in Revit have the analysis wire positions modelled to the 
edges of the object. 
 

 
  
Depending on the slab type used for design purposes within Tekla Structural Designer, this can lead to 
the slab being flagged as unsupported when the model is validated. 
 
The slab wire can be adjusted to ensure connectivity by using the Adjust Analytical Model command 
(see later section). 
 
An alternative is to deselect the Enable Analytical Model flag prior to integrating the model and building 
the slabs within Tekla Structural Designer. By also removing the slabs from the transfer back into Revit, 
you can then retain totally independent slab systems in both modelling systems. 
When considering floor connectivity, we would recommend that the analysis extents of floor instances 
should intersect with supporting beam and wall lines as much as possible. (Exception being floors 
intended for flat slab analysis within Tekla Structural Designer). 
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Sloping slabs 

Sloping slabs created in Revit (using the Slope Arrow option) will be transferred into Tekla Structural 
Designer. 

 

 
 
However, please note that it is not possible to return sloping slabs accurately from Tekla Structural 
Designer due to limitations within the Autodesk API. 
 

If no existing Revit model exists 

For first time import processes, no slab items will be created. The user will be informed of this within the 
log. 
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If merging results into an existing Revit model. 
 

 If the slab has not been adjusted in position, the slab will be physically updated to suit the 
properties exported from Tekla Structural Designer. 
The analysis wire will be reset to follow the horizontal plane and will no longer follow the slope of 
the slab. 

 
 If the slab has been adjusted in position, expanded or contracted in size, then no floor instance 

can be created within Revit. The existing floor will be deleted as part of the update process but no 
replacement floor instance will be created. 

 

Floors and meshing 

Floors should ideally be created so that a minimum of 2” (or 50mm) exists from the edge of any opening 
or from the outline of any column member to the edge of the slab.  
These distances will ensure that the floor slab can be correctly meshed when the analysis stage is 
performed in Tekla Structural Designer. 
If these minimum distances cannot be met within the Revit software, either adjust the analytical model to 
suit or consider removing the floor instance from the integration process and instead have the engineer 
generate the slab within the Tekla Structural Designer software to meet their own requirements. 
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Floor Openings 

Any opening with a polygonal shape or containing a curved edge will be simplified to a rectangular shape 
on import into Tekla Structural Designer.  
The rectangular shape will be drawn to suit the horizontal and vertical extents of the opening plan 
requirements.  
Please note that in some cases this may extend the hole past the outline of the slab and result in the 
opening becoming invalid.  
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3.8 Checking wireframe connectivity of a model within Revit 

We would recommend creating a view within your Revit model or template specifically for analytical 
model connectivity. If your model is based off the standard Autodesk templates then the 3D View: 
Analytical Model can be used however we would also recommend enabling the option to view 
Analytical Nodes within the Visibility/Graphics Overrides command. 
 

 
 
NB. To help with the clarity of the created view, we would recommend disabling the option Show model 
categories in this view (Model Categories tab). Disabling this option will remove all physical objects 
from the view and leave only analytical objects being visible. 
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When using this view, you should be looking for areas where many nodes are located. These can be 
indications of a concentration of unconnected member ends. 
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3.8.1 Check Member Supports 

 

 
 
In addition to visual checks, Revit commands such as Check Member Supports (Analyze tab) 
command can also identify areas where no connectivity can be detected. 

 
As mentioned in the tooltip, the command should identify all unsupported members and report any 
issues within the Review Warnings command (Manage tab). 

 
Some customers may find the Review Warnings command rather cumbersome to navigate though and 
so we would recommend using the Check Member Supports command in conjunction with other 
methods of checking model connectivity. 
 

3.8.2 Color coded nodal views 

We would recommend the use of a color-coded filter based on nodal connectivity. This can then be 
combined with the Analytical Connectivity view (described earlier) to help identify problem areas within 
the model. 
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Creating a color coded view based on nodal connectivity 

Depending on the Revit template that is used, filters relating to node connectivity may already exist. 
However, any predefined filters should be carefully checked to ensure that all available connectivity 
options are covered with both Connected - Auto-Detect and Connected - Manual status’ being 
incorporated in filters 
If the connectivity filters do not exist, please follow the steps below to generate a suitable filter. 
 
With your Analytical Connectivity view active, access the Visibility/Graphics Overrides dialog by either 
clicking on the relevant Edit button within the view properties dialog or by using the VG or VV keyboard 
shortcuts. 
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Click on the Filter tab and then on the Add button to create a new filter. 
 

 
   
When accessing the Add Filters dialog, click on Edit/New against the Rule-based Filters option to 
create a new filter. 
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Click on New to create a new filter and enter the name as being Unconnected Analytical Nodes with 
the filter option as being Define rules.  
Click OK when this information has been entered. 
 

 
  
Once the filter has been created, the Categories and Filter Rules windows should have become active 
allowing certain objects and parameters to be filtered.  
  
Within the Categories window, tick the Analytical Nodes entry. 
Set the Filter Rules to be:- 

 Object :  Connection Status 
 Action :  Equals 
 Search Term :  Unconnected 
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After the Unconnected Analytical Nodes filter has been correctly created, highlight the filter name and 
then use the Duplicate option to create two copies.  
 

 
  
After creating the duplicate, you should have two filters.  
   
Rename the newly created duplicate filter to be Connected Analytical Nodes and change the action for 
the Filter Rules from equals to does not equal.  
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Once the data for all both filters has been correctly created, click on the OK button to return to the Add 
Filters dialog.  
Within the Add Filters dialog, select both filter names to include them into the view and click OK. 
 

 
   
You should now have been returned to the main Visibility/Graphics Overrides dialog and should be 
able to see the filters that have been created. 
  
Click to highlight the entry for Unconnected Analytical Nodes and then choose to Override the Lines 
applied to an object. 
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When editing the line graphic overrides, set the color to be Red. Click OK when done. 
 

 
 
Perform the same override task on the Connected Analytical Nodes filter although please note that the 
color used will be Green. When both overrides have been set, click OK to leave the dialog. 
 

 
  



3 Revit Connectivity and Integration with Tekla Structural Designer 39 (230) 

 

Guidance Notes Autodesk Revit Guidance 
© Trimble Solutions Corporation | December 5, 2019 Tekla Structural Designer Integrator 

 

The color coding overrides should now be applied onto the model. 
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3.9 Manually adjusting the Revit analytical model 

Analytical nodes (and the associated instance analysis wire) can be relocated using the Analytical 
Adjust command (Analyze toolbar). 
 

 
 
To adjust a location, simply click and hold the left mouse button while hovering over a node position. 
Move the mouse onto a member providing support and then use a snap shortcut for the node location 
before finally releasing the mouse button. 

 
An alternative to this is to use the Align command (Modify tab). Please note that adjusting the analytical 
wire position does not affect the physical position of the element. 
 
Openings can be analytically removed from slabs and walls by using the Openings option within the 
Edit Analytical Model submenu. Simply enable or disable the selection box shown in the center of each 
opening to enable or disable the analytical opening. 

 
Click on the Finish command (Edit Analytical Model submenu) to save the positions of any amended 
analytical positions. 
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3.10 Modeling sloped items as being flat for integration purposes 

When using Tekla Structural Designer, it may be required to design very shallow slopes as flat for 
engineering efficiency reasons (e.g. to avoid the problem of modeling non-planar roofs). 

 
The Revit model would still need to be created correctly for BIM sharing and contract documentation 
purposes though. This section runs through the process of creating physically sloping members but 
having the analysis wires specified as following a horizontal plane. 
 
In order to create a sloping member with an analytical wire following a horizontal plane it will be 
necessary to firstly generate the geometry. This will initially set the analysis model as following the model 
geometry. 
 

 
 
As well as generating the sloping member itself, it will be necessary to create either a Level element or a 
Reference Plane for the analysis wire to follow. Once this has been achieved, access the analysis 
properties of the sloping beam instance and flag the analysis wire as following the level/reference plane. 
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As mentioned earlier, this can be done by changing the z-projection settings held under the Analytical 
Alignment section. Change the z-projection alignment to be the same as the adjacent level or reference 
plane (in our example, Level 2). 
 

 
 
The result is that the physical shape of the member still slopes but the analysis wire is now modeled 
horizontally. 
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With the analysis wire now following the flat plane, it may be noted that the wire may extend further than 
the required amount. This is due to Revit calculating the length of the analysis wire over the inclined 
distance rather than the flat distance. 
 

 
 
The wire can be shortened and adjusted so that it then connects to the correct location by using the 
Analytical Adjust command within Revit. If you have trouble in selecting the intersection point, consider 
modeling a dummy member from the intersection point to provide a reference to snap onto. The dummy 
member can be deleted once the operation has been completed. 
An alternative method may be to use the Align command (Modify tab). 
Once the wire location has been corrected, the entire frame can be copied to further required locations 
and then integrated with Tekla Structural Designer. 
 
When the member has been imported into Tekla Structural Designer, the alignment will be set to the 
center of the object. This is due to the analysis wire no longer following the same projection as the 
physical shape. The alignment however will not make any difference to the analysis and design of the 
frame within Tekla Structural Designer. 
 
As long as the beam member is not moved or adjusted in any way within Tekla Structural Designer, the 
analytical wire and offsets will not be affected within the Revit model. 
If the member is moved in Tekla Structural Designer then the physical shape in Revit will be altered to 
suit the settings of the member in Tekla Structural Designer (Aligned center-center as default). 

 
It may be useful to consider performing all geometric changes for non-planar roofs within Revit and only 
performing the analysis process within Tekla Structural Designer. This would then avoid any data from 
being altered to suit the Tekla Structural Designer settings. 
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3.11 Continuous members 

Continuous members originating in Revit should be modelled from end to end in one long piece. Revit 
has no concept of internal member nodes and so the connectivity to any supporting members is defined 
within Tekla Structural Designer.  

 
Once the model has been transferred into Tekla Structural Designer, collision of element errors will be 
encountered at the intended support positions. 
The user should then click on the continuous member, click on the central node and then simply click to 
model a new node on top of the supporting member position(s). This process will then generate the 
correct member fixity over the support position. 

 
On return to Revit, steel members will not be split around the internal node position and will instead be 
returned as one long member. The control to toggle this behavior is held within the Settings command 
(Home tab) within Tekla Structural Designer. 
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3.12 Spliced columns 

 
To model spliced columns within Revit, simply model one column on top of the other. In order to 
recognize the connection as a splice, some criteria must also be met. 

 Both the upper and lower columns modelled in Revit must be Steel Structural Column instances 
 The joint location between columns must be located on a level 
 The joint location must be restrained by Structural Framing instances in both the major and minor 

axis directions. 

 

 
 
If these criteria are met then the splice condition will be integrated into Tekla Structural Designer (with a 
fixed splice offset of 48” or 600mm depending on the unit system used). 
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4 Managing the mapping of sections, families and 
types. 

This section covers the mapping of section sizes within Tekla Structural Designer and the mapping of 
families and types within Autodesk Revit.  
 
As Tekla Structural Designer designs to specific section sizes, it is important to ensure that members 
modelled in the Structural BIM software are recognized on transfer. 
 

4.1 Family location 

For Autodesk Revit users, it is important to ensure that the program looks at the correct location for all 
Revit content. The content may be families generated by Autodesk or it may be content created by the 
customer. 
 

 For users of imperial content, we use an entry in the Places dialog referenced as Imperial 
Library. 

 For users of metric content, we use an entry in the Places dialog referenced as Metric Library. 

 
Please note that the name in the Places dialog must use the exact spelling as written above and the 
location should be set as being the main library directory for that particular country content. 
For example:- 

 USA content :   C:\ProgramData\Autodesk\RVT 20xx\Libraries\US Imperial 
 UK content :   C:\ProgramData\Autodesk\RVT 20xx\Libraries\UK 
 Singapore content :  C:\ProgramData\Autodesk\RVT 20xx\Libraries\Singapore 

 

 
 
The location may also be set as being a server location if content is not directly installed to your local 
drive. 
It is important to ensure that either Imperial Library or Metric Library entries exist within the Places 
dialog. If these dialogs do not exist, correct section mapping may not be automatically determined.  
 
The entry for Tekla Library is automatically generated as part of the first import or export process and 
does not require any sort of manual entry. 
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4.2 Model composition 

Prior to performing an export of a Revit model to Tekla Structural Designer, please take some time to 
review the model and confirm that all of the modelled elements are required within the analysis and 
design model. 
The integration process works on a very simple rule, only items that have a valid analytical element can 
be considered for export. Therefore, any item that does not have the analytical element enabled will not 
be exported from Revit. 
 
Items that are not required can be omitted from any export processes by simply disabling the Enable 
Analytical Model checkbox. This checkbox can be found within the Instance Properties dialog. 
 

 
 
Instances with the Enable Analytical Model checkbox disabled will no longer have an analysis wire, 
and therefore will not be exported. 
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4.3 Unmapped Sections  

4.3.1 From Autodesk Revit into Tekla Structural Designer 

Where members cannot be mapped importing into Tekla Structural Designer, analysis elements will be 
created. Please note that analysis elements cannot be designed within the software. 
 
However, analysis elements can be corrected and altered to beam, column or bracing elements by 
editing the properties dialog within the Tekla Structural Designer software. 
(NB: orientation settings are not needed for analysis elements so no offsets will be transferred for 
analysis element objects and the orientation settings will be lost during the transfer process). 
 

     
 

4.3.2 From Tekla Structural Designer into Autodesk Revit 

Where members are not mapped on import into Autodesk Revit, any unrecognized sections are 
generated by copying an existing type listed in the current Revit project and renaming to suit. 

 
For example, in the following view, any new unrecognized Structural Framing sections would be created 
as a copy of one of the eight highlighted types.  
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The assigned name would be taken from the incoming neutral file but the section shape and properties 
assigned would probably not match the design intent. 
To ensure the correct shape and properties were assigned, family and type mapping would have needed 
to be performed. 
 

 

4.4 Unmapped material 

4.4.1 From Autodesk Revit into Tekla Structural Designer 

Unrecognized material will be flagged during the import process into the Tekla Structural Designer 
software. Users will need to specify the Material Type and Grade of all unrecognized materials before 
being able to continue with the import processes. 
Please note that mapping choices on import can only be set against the predefined material held in the 
Tekla Structural Designer database. It is not possible to map onto user defined material grades even if 
these exist within the model prior to the import process. 
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4.4.2 From Tekla Structural Designer into Autodesk Revit 

It can be common to find that one or more materials require mapping. This is usually related to the Revit 
model or template not containing an appropriate grade to use. 
We would recommend that users update their own templates so that all commonly used materials are 
held within. 
Grades can be mapped as described later within this section, or by keeping the materials unmapped, 
corresponding materials will be generated. 
 
The generated material will be created with the correct name and type (concrete, steel, wood etc.) but 
will contain no analysis information – this should not be a problem however, as we intend for all analysis 
and design procedures to be performed inside the Tekla Structural Designer software. The material 
creation process will also be listed in the log file. 
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4.5 Mapping members 

4.5.1 From Tekla Structural Designer into Autodesk Revit 

The mapping dialog of the integration wizard allows users to identify members, materials or panels which 
are not recognized. 
Unrecognized sections can be mapped by using the Review Mapping option. 
  

 
 
If the Review Mapping switches are selected, the following dialogs will cover the mapping of Structural 
Column objects, Structural Framing objects, Materials and Steel Decks in turn. 
On the individual mapping screen, three styles of icons will be shown:- 

 
Blue circular tick   

 
Both the family and type can be mapped. There is no further work required. 

 
Yellow triangular exclamation marks 

 
The family file can be mapped but the individual type is unrecognized. 

 
Red circular cross icons 

 
The family file cannot be determined; therefore, all types listed underneath are also unrecognized. 
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As Tekla Structural Designer uses a set list of sections within its database, it is rare to see members 
being unrecognized on integration import processes into Autodesk Revit. 

 
Where import processes are not detecting the correct families to use, please check the Places dialog to 
ensure that the entry is valid (see section on Family Location). You may also wish to ensure that the 
location listed contains a full range of families and types. 

 

Use of user defined families and types. 

It is common for users to want to use their own families rather than the Autodesk Revit default content. It 
is therefore possible to choose own families by the use of the Override button to the right hand side of 
the Mapping dialog. 
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Within the Override dialog, the existing entry can be removed and new content can be selected by using 
the Add button and browsing to the required family. Click OK when done. 
 

Important Note: Structural Column and Structural Framing families inside Revit 
contain very different parameters and program hierarchy. Please 
ensure that you do not manually map onto the wrong object 
category. 

 

 
 
Once the family file has been set, the mapping dialog will list the type references underneath. These may 
be recognized as the type names are the same as default Autodesk Revit content but similarly, the 
names may not be recognized. 
For any unrecognized type name, click in the blank cell to the right and choose the section type from the 
dropdown range. 
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After the families and types have been mapped, and there are no red or yellow icons remaining in the 
dialog, click Next to continue. 

 
At this stage, you should be prompted to save your mapping choices as an XML format file mapping file. 
If the file is saved, it will then be used for all future mapping choices (See the Section and Material 
Mapping dialog on future import and export dialogs). 

 
This means then that previous mapped section profiles and/or material does not require repeat work to 
map the same sections again. 
 

4.5.2 From AutoDesk Revit to Tekla Structural Designer 

The same processes that are applicable to imports into Revit are also applicable to Export processes. 
Where the two methods differ however is when the Review Mapping dialog is accessed. 
 
As Tekla Structural Designer uses a very specific list of sections, the Override button is replaced by an 
Advanced button. The Tekla Structural Designer section shape can be chosen from the Export Name 
dropdown by clicking in the blank cell. 
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Once the section shape has been selected, you may find that some mapping is automatically completed 
as the type name being exported matches the same name as the Tekla Structural Designer database 
entry. 
 

 
 
The missing entries can again be manually mapped by clicking on the blank cell under the Export Name 
column and selecting the most appropriate section size. 
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It is also possible to map from one single Revit family into two or more section shapes within Tekla 
Structural Designer by clicking on the Advanced button. 
 
The Advanced Mapping dialog allows multiple Tekla Structural Designer shapes to be chosen and then 
a larger section list will be available from the Mapping dialog. 
 

 
 
Once all of the families and types have been mapped and there are no red or yellow icons remaining in 
the dialog, click Next to continue. 
At this stage, you should be prompted to save your mapping choices as an XML format file mapping file. 
If the file is saved, it will then be used for all future mapping choices (See the Section and Material 
Mapping dialog on future import and export dialogs). 
This means then that previous mapped section profiles and/or material does not require repeat work to 
map the same sections again. 
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4.6 Mapping Steel Decks 

Steel deck profiles inside Revit are used for the mapping and generation of composite floor slabs. The 
family is simply a sketched profile of the repeating shape required for the slab soffit so that the floor 
instance is shown correctly within section views. 
 

 
 

4.6.1 Mapping Steel Decks from Revit to Tekla Structural Designer 

Tekla Structural Designer works with a specific list of decking manufacturers and profiles. Although this 
list can be amended, the integration processes from Revit into Tekla Structural Designer will only allow 
for mapping onto this very specific list. 
 
In order to map decking profiles during export processes from Revit, click in the blank cell adjacent to the 
decking manufacturer name. A dropdown list showing the manufacturer name and the decking profile will 
then appear and you can then select the correct profile. 
 
The gauge should also be mapped in a very similar method. 
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4.6.2 Mapping Steel Decks from Tekla Structural Designer to Autodesk Revit 

If the import process cannot determine the correct family to be used, click on the Override button and 
directly browse to a suitable profile family. 
After performing the mapping, you should be prompted to save your mapping choices as an XML format 
file mapping file. If the file is saved, it will then be used for all future mapping choices. 
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4.7 The Tekla Library 

To help with the integration process, we install an additional library of sections. These are installed into 
the C:\ProgramData\Tekla\Structural\TSD Integrator\20xx\Tekla Library directory as default. 
 

   
 
This library completes the section lists for:- 
• Hollow sections (Hot rolled and Cold Formed) 
• Timber sections 
• Cold rolled steelwork 
• Concrete polygonal columns 
• Other important families (plate girders, fabsec, ribbon cut westok etc.) 
 
For import processes, you may notice that families from this library are used in preference to the default 
Autodesk content. When constructing a model in the Revit environment we would recommend that these 
families be used wherever possible to ensure correct transfer of data. 
 

4.7.1 Unusual/custom shapes from Revit 

The Autodesk Revit user may at times want to model section shapes and sizes that do not exist within 
the Tekla Structural Designer software but still have these elements analyzed. 
Examples of these shapes include box sections built from welded plate fabrications or individual plates 
welded together to form a solid rectangular steel member. 
These items can be exported as being Analysis Elements within the mapping stage. 
 
This provides support for an entire range of bespoke families that can then be transferred to Tekla 
Structural Designer for analytical purposes. 
No analytical properties will be populated in the resulting analytical elements but the project engineer to 
suit their own requirements can generate these. 
 
When an updated results file is provided back to Revit from Tekla Structural Designer, the analytical 
elements will be mapped to the original families and no alterations to these particular families will be 
made. 
 
Where new elements are to be formed from analytical elements generated inside Tekla Structural 
Designer, these will be imported as concrete rectangular members of 100mm x 100mm size (approx. 
4”x 4”) to ensure that no elements are lost from the transfer process. 
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4.8 Specifying Tekla Structural Designer object types within Revit. 

When objects are imported from Revit into Tekla Structural Designer, the style of the object is set to be a 
copy of the item in the BIM software (e.g. beam instances will be integrated into Tekla Structural 
Designer as beam objects, bracing instances as brace objects etc.). 
 
It is possible to override this though and stipulate the object style on import by setting text in the type 
field. The following text can be set within the TSDI_TYPE parameter on each object to force the element 
to be imported as that style of object within Tekla Structural Designer. 
 
Some of the entries relating to Portal Frames cannot be imported into Tekla Structural Designer at 
present and are only included for list completion. 
 

TSDI_TYPE entry Description 

Columns 
 

SIMPLE_COLUMN Column with the simple design option checked 

GENERAL_COLUMN Column with the simple design option unchecked 

GABLE_POST Gable post member 

Beams and Braces 
 

COMP_BEAM Composite beam – No edge conditions set 

EDGE_COMPOSITE_BEAM Edge condition composite beam 

INT_COMPOSITE_BEAM Internal condition composite beam 

GENERAL_BEAM Beam member 

BRACE Bracing member 

JOIST USA joist member 

SB_CANTILEVER_A Cantilevered beam; free at start end 

SB_CANTILEVER_B Cantilevered beam; free at finish end 

GB_FREE_END_A General beam; free at start end 

GB_FREE_END_B General beam; free at finish end 

GB_FREE_BOTH_ENDS Multi-span general beam member 

WSTK_WESTOK Ribbon cut Westok beam 

WSTK_CANTILEVER_A Cantilevered Westok member; free at start end 

WSTK_CANTILEVER_B Cantilevered Westok member; free at finish end 

ANALYSIS Analysis element 

EAVES_BEAM Eaves beam member 

RAIL Sheeting rail member 

PURLIN Purlin member 
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Truss Members 
 

INT_TRUSS Internal truss member 

SIDE_TRUSS Side truss member 

TOP_TRUSS Top chord of truss 

BOT_TRUSS Bottom chord of truss 

Portal Sections 
 

PORTAL_COLUMN Portal frame stanchion 
(export from Tekla Structural Designer only) 

PORTAL_RAFTER Portal frame rafter 
(export from Tekla Structural Designer only) 

PORTAL_TIE Portal frame tie member 
(export from Tekla Structural Designer only) 

PARAPET_POST Portal frame parapet post 
(export from Tekla Structural Designer only) 

Shear Walls 
 

MESHED Shear wall using mesh analysis method 

MID_PIER Shear wall under mid-pier theory 

Slabs 
 

RC_SLAB Two way spanning slab on beams 

RC_SLAB_1WAY One way spanning slab on beams 

COMP_SLAB Composite slab 

FLAT_SLAB Flat slab 

CAST_SLAB Precast slab 

STEEL_DECK Two way spanning steel deck slab 

STEEL_DECK_1WAY One way spanning steel deck slab 

TIMBER_DECK Timber deck slab 

 

  
  
  

  



4 Managing the mapping of sections, families and types. 63 (230) 

 

Guidance Notes Autodesk Revit Guidance 
© Trimble Solutions Corporation | December 5, 2019 Tekla Structural Designer Integrator 

 

4.9 Specific Object Mapping 

4.9.1 Autodesign sections 

Autodesign sections are members that have been flagged as autodesigned within the Tekla Structural 
Designer software but have not undergone any part of the design process yet. 
Revit will import any member which has been flagged as autodesigned as a TSD_Autodesign type. This 
is an I-section shape of 100mm depth (3.937”) and 60mm (2.362”) width. 
 
We would recommend that the Tekla Structural Designer validation process is completed correctly and 
models are designed before performing any sort of export to Revit. This ensures that correctly designed 
section sizes are integrated.  
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It is also possible to export any member from Revit as being a TSD_Autodesign section. This imports 
the member into Tekla Structural Designer as the default section for the particular order file being used 
and with the AutoDesign check being enabled. 
The option to do this is held within the Advanced Mapping dialog. 
 

 
  

4.9.2 Concrete Families and Types within Revit 

When exporting Concrete shapes from Revit to Tekla Structural Designer, please be aware that we 
actively search for two specific parameters:- 

 b 
 h 

These two parameters must exist within the family otherwise; the export process will fail during the 
processing stage. If users wish to use their own parameters, please create the two required parameters 
and flag these as being populated by the main breadth and depth parameters. 
Please note that the b and h parameters must be listed under the Dimensions branch. 
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4.9.3 Adding parameters to existing families. 

This section covers the alteration of an existing family to introduce parameters b and h and to have these 
parameters populated by the existing parameters for the breadth and depth of the family. 
 
Open the family within a session of Revit by either directly opening the .rfa file or by using the command 
Edit Family within an existing Revit project. 
 
To view the existing parameters, click on the Family Types command. 
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Within the Family Types dialog, we can see that this particular family is using the parameters Beam 
Breadth and Beam Depth rather than the traditional b and h parameters to control its size. We will 
therefore have to introduce the b and h parameters. 
 
Click on the New Parameter command. 
 

 
 
When accessing the Parameter Properties dialog, set the name as being b. Keep the remaining 
parameters at the default settings. 
Parameter Type:  Family Parameter 
Discipline:   Common 
Type of parameter: Length 
Group parameter under:  Dimensions 
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Click OK when done and then repeat the process to create parameter h. 
 
After creating parameters b and h, flag these as being copies of the existing breadth and depth 
parameters by typing the values in the Formula field. If the entries are typed correctly then the Value 
field should update automatically (click in another field or press Enter to finalize the data entry). 
 

 
 
Click OK to exit the dialog and either use the Save command to save the Family for use later, or use the 
command Load into Project to update an existing Revit project. 
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4.9.4 Truss members 

 

 
 
Structural Truss elements within Revit are specialized items. All types within a truss family share the 
same profile layout with individual types specified within the truss hosting other parameters, such as the 
structural framing families used for modeling chords and web members. 
 
Structural Truss elements are grouped together and displayed as a series of dashed blue lines. 
Structural Truss objects generally lock the type parameters for individual members and pin the sub-
instances so that positions cannot be easily adjusted. 
 
When it comes to the integration of Structural Truss instances, all trusses and instances held within the 
assembly will be exported from Revit and imported into Tekla Structural Designer as a series of 
individual truss members. 
Please note however that due to a restriction of the AutoDesk API, Structural Truss elements cannot be 
imported into Revit. This means that when design results are returned from Tekla Structural Designer, 
vertical elements will be altered to become Structural Column objects. 
 
Due to the limitations of Structural Truss objects and the pinning of the individual boom and strut 
instances, the update process will be unable to adjust material grades, section sizes or positions. 
We would recommend that Structural Truss families be exploded to allow correct round tripping.  
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4.9.5 Plate Girders, Plated Columns, Fabsec Beams and Westok Plate 
Girders 

Plated sections of varying depths and widths can be modelled within Revit by using the families installed 
as part of the Tekla Library. These are:- 
 
Plated Column 

 C:\ProgramData\Tekla\Structural\TSD Integrator\20xx\Tekla Library\Columns\Steel\Plate Column.rfa 

Plate Girder Beam 
 C:\ProgramData\Tekla\Structural\TSD Integrator\20xx\Tekla Library\Framing\Steel\Plate Girder.rfa 

Fabsec Beam 
 C:\ProgramData\Tekla\Structural\TSD Integrator\20xx\Tekla Library\Framing\Steel\Fabsec.rfa 

Westok Plate Girder Beam 
 C:\ProgramData\Tekla\Structural\TSD Integrator\20xx\Tekla Library\Framing\Steel\Westok Plate Girder.rfa 

 
It is also possible to use custom Revit families to show similar representations within the Revit project. 
Please note however that for mapping purposes, it is necessary to map the section type through the 
Advanced Mapping dialogs for Structural Column and Structural Framing families. 
 

 
It should also be noted that the integration requires six specific parameters to be generated. These are:- 

 Depth;  d 
 Top flange breadth;  bt 
 Bottom flange breadth;  bb 
 Top flange thickness;  tft 
 Bottom flange thickness;  tfb 
 Web thickness;   tw 

 
These parameters must be generated for successful integration to occur. 
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4.9.6 Westok Ribbon Cut beams 

 
Westok beams are a modern version of the traditional castellated beam, but far more flexible and with a 
greater range and depth of applications. They are primarily used within the UK region and manufactured 
by Kloeckner Metals. 
 

 
 
Users of Revit may notice that they have four families that can be used to model Westok Sections. 
 
Cellular Beam 

 C:\ProgramData\Autodesk\RVT 20xx\Libraries\UK\Structural Framing\Steel\Cellular Beam.rfa 

Cellular Beam with un-Equidistant End Holes 
 C:\ProgramData\Autodesk\RVT 20xx\Libraries\UK\Structural Framing\Steel\Cellular Beam with un-Equidistant End 

Holes.rfa 

Westok Ribbon Cut 
 C:\ProgramData\Tekla\Structural\TSD Integrator\20xx\Tekla Library\Framing\Steel\Westok Ribbon Cut.rfa 

Westok Ribbon Cut Short 
 C:\ProgramData\Tekla\Structural\TSD Integrator\20xx\Tekla Library\Framing\Steel\Westok Ribbon Cut Short.rfa 

 
We would advise that the family Westok Ribbon Cut.rfa is the correct file to be used for the following 
reasons:- 
 

 Cellular Beam.rfa 
Sets out all web openings incorrectly (from the center of the section) and calculates the beam 
depth incorrectly. 

 
 Cellular Beam with un-Equidistant End Holes.rfa 

Sets out the web openings correctly but calculates the (fixed) depth using a formula which does 
not take account of ribbon cutting techniques. 

 
 Westok Ribbon Cut.rfa 

Sets out the web openings correctly and allows for variable depths of tee sections. This is the 
correct family to use. 

 
 Westok Ribbon Cut Short.rfa 

This should only be used for automated import processes where designers have mistakenly 
generated extremely short Ribbon Cut Westok sections within Tekla Structural Designer and no 
cellular openings would be present. 

 
When using the family Westok Ribbon Cut.rfa, users may note that there are a number of parameters 
that require details. These are detailed as following 
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Construction Parameters 

h1  Half of the Cellular Hole Diameter 
(can be auto-calculated from parameter Do) 

h2  Half of the Cellular Hole Diameter 
(can be auto-calculated from parameter Do) 

Setback Right User defined distance to make allowance of the difference between the analytical length and cut (solid) 
length of the beam. 

Setback Left User defined distance to make allowance of the difference between the analytical length and cut (solid) 
length of the beam. 

S1  Dimension from the start end of the cut shape to the center of the first cellular opening. 

S  Cellular Hole Horizontal Spacing (Hole Centers) 

Do  Cellular Hole Diameter 

Structural Parameters 

Name1 The ‘TYPE’ value (section name) of the upper tee section. 

W1 Section weight (kg/m) of the upper tee section 

Name2 The ‘TYPE’ value (section name) of the lower tee section. 

W2 Section weight (kg/m) of the lower tee section 

If these parameters are set to unrecognized section names, then mapping problems may occur related to the Westok Tee 
section. The Westok Tee entry should be mapped to a recognized UB, UC or Corus Advanced equivalent section. If the 
Westok Tee section is not correctly mapped then no information will be set for the beam. 

Dimension Parameters 

Top Base Member 

d1 The overall depth of the upper section. 

bf1 The flange width of the upper section. 

tf1 The flange thickness of the upper section. 

tw1 Web thickness of the upper section. 

k1 The distance of the flange thickness added to the root radius. 

Bottom Base Member 

d2 The overall depth of the lower section. 

bf2 The flange width of the lower section. 

tf2 The flange thickness of the lower section. 

tw2 Web thickness of the lower section. 

k2 The distance of the flange thickness added to the root radius. 
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4.9.7 Portal Frames 

Portal Frames are specialized long span, low-rise moment frames generally used in the UK construction 
market. Portal Frame objects in Tekla Structural Designer are modelled as a single element that contains 
the stanchions, rafters and haunch objects. 
 
Please note that Portal Frame objects are entirely different from regular moment frames modelled from 
several column and beam elements. 
 

 
 
As these frames are modelled as one item within Tekla Structural Designer, there are some rules 
governing the integration transfer into Revit. 
 

 Portal Frame objects can only be exported from Tekla Structural Designer and imported into 
Revit. They cannot be exported from Revit and imported into Tekla Structural Designer. 

 Eaves haunches and apex haunches will not be transferred by the integration process, as there 
are no corresponding objects within Revit that can be used. 

 Portal Frame objects will be ‘exploded’ on export into the constituent Structural Column and 
Structural Framing instances. 
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4.9.8 Floor elements 

Floor objects will be mapped from Revit to Tekla Structural Designer with the outline of the resulting slab 
being identical to the analytical outline within the Revit model. 
For this reason, it is important to ensure that slabs are analytically connected (see previous section) and 
some simple rules are followed. 
 

 Floors with two distinct outlines in a single floor definition will not be exported. Please use two 
separate floor instances within Revit if this is the intent. 

 

 
 

 Avoid curved edges abutting curved edges. This may on occasion cause issues with the 
processing of the analysis wire. Try to separate curved edges with a small linear edge (We 
recommend a minimum length of 3/32” (or 3mm)). 

 

 
 

 Ensure that the floor outline does not self-intersect. 
 

 Holes drawn as part of the slab outline are beyond the scope of the integration process. Use 
shaft openings, vertical opening or Opening by face commands to model any hole requirements. 
Openings drawn as part of the floor boundary will not be transferred although the opening intent 
will be shown as a sketched outline. 

 
Floors should ideally be created so that a minimum of 2” or 50mm exists from the edge of any opening, 
or from the outline of any column member to the edge of the slab.  
These distances will ensure that the floor slab can be correctly meshed when the analysis stage is 
performed in Tekla Structural Designer. 
If these minimum distances cannot be met within the Revit software, consider removing the floor 
instance from the integration process and instead have the engineer generate the slab within the Tekla 
Structural Designer software to meet his or her own requirements. 
 



4 Managing the mapping of sections, families and types. 74 (230) 

 

Guidance Notes Autodesk Revit Guidance 
© Trimble Solutions Corporation | December 5, 2019 Tekla Structural Designer Integrator 

 

4.9.9 Wall elements 

Wall elements in Autodesk Revit are exported to Tekla Structural Designer based on the Structural 
Usage setting:- 

 Bearing   : Exports the wall as a Bearing Wall element. 
 Shear   : Exports the wall as a Concrete Wall element. 
 Structural Combined : Exports the wall as a Concrete Wall element. 

 

 
 
In addition to this setting, the Function property (listed under Type properties) must be set as either an 
Interior wall, Exterior wall or Core-Shaft wall. All other Function settings will result in the wall being 
omitted from the export process. 
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We would strongly recommend that all users are aware of the analytical differences between a Bearing 
Wall and a Concrete Wall. 
Please note that Walls are ALWAYS initially created in Revit as Bearing walls, the Structural Usage 
field cannot be modified until the wall has been generated. 
 

 
 

4.9.9.1 Bearing Walls 

Bearing Wall elements create a number of internal vertical elements (with a base minimum of five 
elements), based on the aspect ratio of the wall. 

 
 The lower the wall height, the more vertical elements will be created. 

 
More vertical elements per wall will have an effect on the performance of the import into Tekla Structural 
Designer, and the creation (and validation) of the solver model. 
The use and position of Bearing Walls needs to be considered with care as they offer only limited 
structural capabilities. 
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4.9.10 Foundation objects 

 

Structural Foundation objects 

Structural Foundation category instances are beyond the scope of the integrator. This is due to 
Structural Foundations within Revit having no ability to adjust the analytical model. Structural Foundation 
objects will show an analytical wire within the object but this cannot be adjusted to support eccentric 
positions or support variable foundation depths. 
In addition to this, Structural Foundations do not easily provide support for non-rectangular pad 
arrangements and non-standard pile arrangements. Users will also notice that the vast majority of 
analytical settings are not available when using Structural Foundation objects. 
Due to these limitations, we provide support for Floor objects as these can provide bi-directional 
integration along with supporting alterations to sizes, eccentricities and pile positions. 

Foundations imported from Tekla Structural Designer 

Foundation objects can be integrated from Tekla Structural Designer to Autodesk Revit. These objects 
include: 

 Pad Base Column objects 
 Strip Base Wall objects 
 Pile Cap Column objects 

These objects are integrated as floor objects and although the instance is initially created from the import 
from Tekla Structural Designer, size alterations made inside Autodesk Revit may be returned. 
No foundation objects created from scratch with Autodesk Revit can be integrated into Tekla Structural 
Designer due to the limitations listed in the section above. 

Foundation Piles imported from Tekla Structural Designer 

Piles modelled in Tekla Structural Designer will be integrated as individual Structural Column instances 
into Autodesk Revit. Changes made to the piling configuration such as numbers of piles, pile location, 
pile shapes or piling lengths will be maintained and returned to Tekla Structural Designer, albeit as a 
new piling type within the software. 
No piles created from scratch with Autodesk Revit will be integrated into Tekla Structural Designer. 
 

4.9.11 Column Drop Objects 

Column drops are imported from Tekla Structural Designer into Autodesk Revit as Floor objects. The 
shape of the drop head is controlled by Tekla Structural Designer, so although the object can be 
returned from Autodesk Revit, no size alterations can be returned. 
No drop heads created from scratch with Autodesk Revit can be integrated into Tekla Structural 
Designer. 
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5 Synchronization 

5.1 Overview 

Synchronization may be performed at any time, although we would always recommend that exports from 
Tekla Structural Designer be performed after the design process has been completed. 
 

5.1.1 Information Transferred 

From Autodesk Revit to Tekla Structural Designer 

The following information is transferred from Autodesk Revit to Tekla Structural Designer:- 
 All grid lines in Autodesk Revit are imported. 
 All levels in Autodesk Revit are imported as levels with floor and diaphragm flags set. 
 There is no suitable mapping between Boundary Conditions in Autodesk Revit and Supports in 

Tekla Structural Designer, so by default supports are created at the bottom of every column 
unless a supporting member can be detected. 

 All selected Autodesk Revit beams, columns and braces are imported, including curved beams. 
Their snap alignment position, orientation, material type, grade and section size will be 
maintained. In addition:- 

o Member releases at the ends of the physical members will be maintained. 
o In Autodesk Revit, horizontal brace should be defined as beams with the structural usage 

property set to horizontal brace. 
o Structural Parametric Trusses are identified as Tekla Structural Designer Truss Members. 
o US Joists are transferred from Autodesk Revit to Tekla Structural Designer as Steel Joist 

objects. 
o Slanted columns are handled. 

 All selected Autodesk Revit Slab objects will be imported:- 
o Horizontal and sloping slabs will be imported as slabs covering the same area. Holes 

where they have been modeled in the Revit model will be transferred to suit the 
requirements of the Tekla Structural Designer software. 

o Slabs in Autodesk Revit without concrete plank or decking information will be transferred 
as generic slabs. These can be differentiated using the TSDI_Type parameter. 

o Slab with a metal deck layer or the appropriate shared parameter will be defined as 
composite slabs with the relevant decking. 

o Slabs with concrete plank shared parameters will be defined as composite slabs with the 
relevant precast concrete plank. Please note that the planks themselves are not 
supported yet. 

o Slab span direction will be determined and imported. To set the span direction in Revit, 
refer to the Autodesk Revit Help. 

 All selected Autodesk Revit Walls will be transferred. 
o Composite and cavity walls cannot be transferred. 

 
Please also note that due to the current limitations of Autodesk Revit, certain items may have to be 
modeled as in-place families. Due to the lack of analysis settings, these items will be flagged as non-
structural and the export process will not consider them. 

Limitations 

The following limitations exist in the current release:- 
 No curved walls or warped structural concrete slabs 
 No Foundation objects created within Revit 
 No Rebar objects 
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 No precast concrete beams or columns 
 No web openings and stiffeners 
 No slab overhangs will be returned 
 Portal Frame members will not be exported to Tekla Structural Designer. This is because it is not 

yet possible to create full Portal Frames in Revit with haunches and correctly positioned physical 
members. 

 

5.1.2 From Tekla Structural Designer to Autodesk Revit 

Information Transferred 

The following information is transferred from Tekla Structural Designer to Autodesk Revit:- 
 All grid lines in Tekla Structural Designer are exported. 
 All construction levels are exported if set to floor. 
 All Columns are exported; all rotations are exported. For concrete filled columns, a user attribute 

of concrete grade is also set up. 
 All Beams are exported; all rotations and end releases are exported. 

o For Composite Beams, the standard Revit parameters Camber Size and Number of 
Studs are populated. 

o If a Beam changes size along its length in Tekla Structural Designer, it will be split into 
separate physical members. 

 US Steel Joists are exported including Special Joists and Joist Girders although the physical 
representation of the latter two categories will be limited in Revit. 

 All Truss Members are exported; all rotations and end releases are exported. 
 Braces are exported. 
 Portal Frames are exported as separate members but due to limitations in the Revit API, 

haunches are not exported and the physical positions of various members will need to be 
adjusted.  

o As a result, it is not possible to export such members back to Tekla Structural Designer. 
 Slabs are exported with metal deck or concrete plank information as appropriate –where 

possible, metal decks will be represented physically, where not possible they will be represented 
by shared parameters. 

 Foundations in the shape of Pad Base Columns and Strip Base Walls are transferred as 
Autodesk Revit Floor objects. These items will also be returned to Tekla Structural Designer in 
the case of updating the Tekla Structural Designer model with changes made in Revit. 

 Foundation piles are integrated as Structural Column objects. Note that both pile caps and pile 
objects are imported as individual object instances. 

 Please note that (new) foundation items created from scratch inside Revit will not be transferred 
into Tekla Structural Designer. 

 Shear Walls are exported. 
 All bearing walls are exported. 

 

Limitations 

The following limitations exist in the current release:- 
 Column, brace and truss member snap points and offsets are not exported. 
 Beam snap points are exported but not offsets. 
 No wind walls are exported. 
 No roofs are exported. 
 No connection information is exported. 
 No loading, load case or load combination information is exported. 
 In addition, due to current limitations in Autodesk Revit itself and operations it permits during the 

import process then :- 
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o Grid line moving may not work 100%. 
o The section sizes in Revit Trusses can be updated, but no geometric changes can be 

made. 
o It is not possible to update the floor type of an existing slab or its outline during the import 

process, so modified slabs are deleted and replaced with new items. 
o It is not possible to create a new slab with metal deck unless at least one floor type was 

previously loaded into the model with the correct profile, (i.e. the user should load from 
the Autodesk Revit library and search for the relevant deck profile).  
If this has not been done, then the slab will be imported with no deck and the user will be 
warned to update it manually. 

 Bison Planks cannot be modeled physically in Revit, but information is available through shared 
parameters. 

 It is not possible to create analytically sloping slabs in Revit. The user will be warned, but nothing 
will be imported. 

 Structural Framing Tags are not created automatically for new beams and braces. These can be 
added by using the Tag or Tag All Not Tagged commands in the Annotate Menu. 

 Span direction symbols are not created automatically for new slabs. These can be added 
manually using the Span Direction command in the Annotate Menu. 

 Autodesk Revit does not currently have the ability to handle a number of section types (e.g. some 
SlimFlor beams, some deck types and some cold rolled members may be missing). Users with 
models containing these section types need to take care when transferring models. 

5.1.3 Information retained within Tekla Structural Designer when merging 
models from Revit. 

The following information is not transferred once created in Tekla Structural Designer but is maintained 
during any merge processes. 

 Floor settings for diaphragms, imposed load reduction settings. 
o Identical floor settings will be reset. 

 Column attributes including :- 
o design criteria, 
o Releases, 
o restraints and effective lengths, 
o Notional eccentricities. 

 Beam attributes including:- 
o design criteria, 
o support types, 
o restraints and effective lengths, 
o floor construction, 
o effective widths, 
o stud layout, 
o Westok data not modeled in Autodesk Revit. 

 Brace attributes including:- 
o Connection type. 
o Analysis attributes. 
o Tension/compression design attributes. 

 Support data at the base of columns only. 
 Loading and combinations including all Wind Data. 
 Roof and Wall positions and attributes. 
 Analysis and design options. 
 List of Frames. 
 Selection Groups. 
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5.2 Part models 
Part models can be exported from both Tekla Structural Designer and Autodesk Revit. 
 

5.2.1 From Tekla Structural Designer 

For managing partial model exports, the BIM Status view (which is contained in the Review mode) allows 
control over the status of each object in the Tekla Structural Designer software. The status is color 
coordinated so that the engineer can easily determine the BIM status of each item. 
 

 
 
In addition to viewing the status of each item, the BIM Status command also allows you to exclude items 
from the BIM Integration process by simply clicking on them. 
Selecting the element in this way will change the color to cyan indicating that it is now excluded from BIM 
Integration and will no longer be exported. This option works as a toggle so that if the wrong member is 
selected; simply click on the element again to return it to its original coloring. 
 
Using scene content to control the items visible on the screen at any one time can also help with the 
selection process. This allows users to quickly include or exclude objects from the BIM integration 
process.  
 
An additional command to toggle the BIM Status of all objects is also available within this screen by right 
clicking on the mouse button. 
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It should also be noted that global export filters also exist within the Structural BIM export command. 
These allow you to transfer models based on just grids and levels, members, walls and slabs only if 
required.  
This set of options can be complemented by the import options available within the Autodesk Revit 
integrator to ensure correct partial model transfer to be achieved. 
 

5.2.2 From Autodesk Revit 

Selecting objects prior to performing an export process will flag that only the selected objects will be 
exported from Revit as a default. 

 
 

5.2.3 Items omitted from the selection process 

The Revit Integrator is currently unable to differentiate between deleted items and omitted items at 
present. The result is that the integrator believes that any item not been exported from Tekla Structural 
Designer has been deleted and removes the corresponding object from the merged Revit model. 
To avoid this from occurring, select the items within Revit which are affected by the export from Tekla 
Structural Designer prior to running the import/merge process. By default, only the selected objects will 
be updated in the model and the remaining (omitted) objects will not be affected at all by the merge 
process. 
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5.3 Integration management 

It is possible to change changes made to the model as part of the merge process, in both Tekla 
Structural Designer and within Revit. 

5.3.1 Integration management in Tekla Structural Designer     

Once the synchronization process has been completed, the command BIM Status (held under the 
Review tab) can be used to provide a color-coded indication of how the model has been affected in the 
last import. This view identifies all the changes to Tekla Structural Designer members and slabs that 
have occurred because of the merge process.  
 

 
  
 

Color Description 

New Object has been created in Tekla Structural Designer and has not yet been exported to Autodesk Revit. 

Imported Object has been created by the import from Autodesk Revit. 

Exported Object has been previously exported to Autodesk Revit and has not been altered by any subsequent merge 
processes. 

Updated Member has been modified because of the Structural BIM import. 
Check the BIM status tree for details. 

Deleted Object has been deleted in Autodesk Revit but has been retained during the merge process due to the 
Integration Filter settings. 

Excluded Object will not be communicated from Tekla Structural Designer to Autodesk Revit. 

Not 
Modified 

Object has not been modified in any way during the last merge process. 

 
New indicates members that have not been communicated to Autodesk Revit yet. As Autodesk Revit 
should hold the master physical model, it is advisable to first export the Tekla Structural Designer to 
Autodesk Revit and then perform the merge again with the updated Autodesk Revit model.  
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5.3.2 Structural BIM Import Status Tree     

Once the synchronization process has been completed, the Structural BIM Import status tree (held under 
the Status tab) will show all newly created items or modifications performed by the merge process. 
These alterations to the model can be identified by double clicking on each entry in turn. This will 
highlight the affected member/object within the main Structure 3D view. 
 

 
 
This status list can then be used to track alterations made to the model in the last import process. 
  

5.3.3 Integration management in Autodesk Revit 

Interrogating the log files created on import and export from Revit may help identify altered elements. 
The log files are automatically saved to the same location where the CXL file was located, and can be 
opened with any text editor program. Elements with ID references listed can be found using the Select 
by ID command held in the Manage tab. 
 

 
 
One of the shared parameters transferred from Tekla Structural Designer to Revit is the 
TSDI_Integration_Status parameter that indicates members that are newly created, updated or 
unchanged during the last integration process. 
 

 
 
Using an Autodesk Revit filter to color items based on the TSDI_Integration_Status parameter will allow 
you to easily identify members that have been integrated. 
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5.4 Creating an Integration Status filter and applying to a drawing view 

This section will describe how to create a filter which can be applied onto a 3D view (but potentially onto 
any Revit view) to set color-coding onto the structural items. The color-coding applied should then match 
the same capabilities of the Tekla Structural Designer command BIM Status. 
 
The filter works on the settings applied onto members, panels and walls with the 
TSDI_Integration_Status parameter. Using the various settings of this parameter, we can set up the 
filter accordingly. 
 
Create a new 3D view for the integration status settings by clicking on the View tab and using the 
command 3D View - Default 3D View. 
 

 
  
This should create a new view titled {3D}.  
   
Please note that if this view name already exists within your project, please rename the existing view in 
order to be able to create a new 3D Isometric view. 
Rename the new 3D view by right clicking over the name held in the project browser and choosing the 
option Rename. Set the name to be Tekla Integration Status.  
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Once the view has been created and renamed, access the Visibility/Graphics Overrides dialog by 
either clicking on the relevant Edit button within the view properties dialog or by using the VG or VV 
keyboard shortcuts. 
 

 
  
Click on the Filter tab and then on the Add button to create a new filter. 
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When accessing the Add Filters dialog, click on Edit/New to create a new filter. 
 

 
 
Click on New to create a new filter and enter the name as being Unchanged with the filter option as 
being Define rules.  
 

 
   
Click OK when this information has been entered. 
Once the filter has been created, the categories and filter rules fields should have become active 
allowing certain objects and parameters to be filtered.  
  
Within the categories window, tick the following entries: 
• Floors 
• Structural Columns 
• Structural Framing 
• Walls 
 
Set the filter rules to be- 
• TSDI_Integration_Status 
• Equals 
• Unchanged 
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After the Unchanged filter has been correctly created, highlight the filter name and then use the 
Duplicate option to create two copies.  
 

 
  
After creating the two duplicates, you should have three filters.  
Rename one of the filter duplicates to be Updated and change the data entry for the Filter Rules from 
Unchanged to be Updated.  
Rename the second duplicated filter to be New. Similarly alter the data entry for the Filter Rules from 
Unchanged to be New. 
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Once the data for all three filters has been correctly created, click on the OK button to return to the Add 
Filters dialog.  
Within the Add Filters dialog, you can choose all three filter names to apply directly onto the drawing 
view. Click OK when the selection is made. 
 

 
   
You should now have been returned to the main Visibility/Graphics Overrides dialog and should be 
able to see the three filters that have been created. 
   
Click to highlight the entry for Unchanged and then choose to Override the Patterns applied on the 
surface of an object. 
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When editing the pattern overrides, set the Foreground color to be RGB 255-000-255 and the pattern to 
be Solid Fill.  
Click OK when done. 
 

 
 
Perform the same override task on the Updated and New filters although please note that the colors 
used will alter.  
Updated: RGB 255-255-128  
New: 000-128-000.  
When foreground pattern overrides for all three filters have been set, click OK to leave the dialog. 
 
The color coding overrides should now be applied onto the model. This will allow you to easily identify 
which members are new, updated or unchanged. This is very similar to the BIM Status command within 
Tekla Structural Designer. 
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6 Other Information 

6.1 Grid Lines and Construction Lines 

Please be aware that there is a clear difference between Grid objects and Construction Line objects 
within the Tekla Structural Designer software :- 

 Construction Lines are view specific objects and only appear on the view that they were created 
in. 

 Construction Lines will not be exported to Revit. 

 

6.1.1 Grids transferred from Revit into Tekla Structural Designer 

For gridlines, all gridlines in the model will be transferred. There are no practical limitations to the 
symbols used for the gridline references or the level references. We would obviously recommend the 
use of clear and concise references for your own benefit though. 
 

 
 

6.1.2 For initial imports into Revit (i.e. No existing Revit model exists) 

All grid information from Tekla Structural Designer will be imported into Autodesk Revit using identical 
element definition points. 
As the amount of grids used in the Tekla Structural Designer model may not meet the requirements of 
the Revit user, extraneous grids may be removed or new entries added to suit their needs. 
 

6.1.3 For merging results into Revit (i.e. Returning information into an existing 
Revit model) 

When merging results from Tekla Structural Designer into Revit, the API restricts the modification of 
existing grid objects. 
If grids have been moved, lengthened or shortened within Tekla Structural Designer, the API requires 
the deletion of the existing grid and its replacement with a new grid object. 
As this will have an effect on any predefined dimensions or sheets within Revit, we recommend that 
grids are not included in any updates to the Revit model. 
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6.2 Construction levels 

6.2.1 Floor Setting 

When generating levels within Tekla Structural Designer, it is important to understand that not all levels 
need to be transferred using the Integrator. 
 
For levels generated in Tekla Structural Designer, only levels that have been flagged as Floor items will 
be exported. The exception to this rule is the lowest most entry in the dialog, which is ALWAYS 
exported, regardless of the Floor flag setting. 
 
E.g. When looking at the example below, we find that four levels would be exported. Three of the levels 
are flagged as Floor whilst the lowest most level is always exported. 
 

 
 

6.2.2 Level Type 

Level entities in Tekla Structural Designer can be defined as Structural Slab Level (SSL), Top of 
Foundations (TOF) or Top of Steel (TOS). Concerning the integration process with Revit, this affects 
the vertical slab location. 
Where levels are defined as Top of Steel, the slab will be offset equal to its depth so that the underside 
of the slab is located in line with the level entity. 
Where levels are defined as either Structural Slab Level of Top of Foundations, the slab will not be 
offset. The top of the slab will be in line with the level entity. 
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6.2.3 Level Source 

Tekla Structural Designer can use the concept of source levels to duplicate the content and simplify the 
modelling process. It is important to note that Revit has no concept of duplicate floors within the 
software, therefore duplicate levels are imported into Revit as independent unique 
levels. 
If this model is then returned from Revit to Tekla Structural Designer, the source/duplication settings are 
reset during the merge process and all levels are flagged as unique. 
No items will be physically lost as part of this change and the flag can be reapplied if necessary. 
 

 
 

6.2.4 Level transfer from Revit into Tekla Structural Designer 

When exporting models from Revit, please note that only levels containing a structural node will be 
exported. 

For levels created when importing a model into Tekla Structural Designer, levels will be generated where 
either:- 

 A level has been exported from Revit (see following section) 
 Three or more beam or joist members are on the same horizontal plane 
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6.3 Working with Real World Coordinates 

It is usual to find Revit models located to real world coordinates by use of the Specify Coordinate at 
Points or the Project Base Point features. 
It is usual to find analysis and design software requiring models to be generated around the 0,0,0 base 
datum to avoid rounding errors or any other sort of numerical discrepancies from occurring. Therefore, 
most Analysis and Design software packages do not support the use of real world coordinates within 
projects. 
 
To remove this as being a potential issue from any integration processes, Tekla Structural Designer will 
allow users to relocate models from real world coordinate positions during the import process. 
 

 
 
When using the BIM Import command, the Relocate Import Model dialog will show the coordinate 
range of the incoming model on the right hand side. Please note that the Project Base Point entry is not 
directly recorded to the CXL file format and so users should liaise with the Revit user to be able to 
correctly relocate the incoming model to suit. 
 

 
Please note that a similar dialog is also shown during the Export to Revit command wizard. Users 
should ensure that the same distances that were used to import the model into Tekla Structural Designer 
are also used when exporting data from Tekla Structural Designer. 
Failure to use the same distances may result in the import of updates into Revit relocating the model to a 
different location. 
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6.4 End releases 

End release conditions are transferred between Revit and Tekla Structural Designer. 
Therefore, for models originating from Revit, it is important to ensure that release information has been 
correctly defined prior to transfer. 
Releases for each instance are set within the Analytical Properties dialog. 
 

 
   
Note that the default end release setting for Structural Framing members (including Steel Beams) is to 
have Fixed ends. This may have an effect on the stability of the resulting Analysis and Design model. 
Members can be adjusted en-masse within the Autodesk Revit software by the use of selection filter 
commands. 
 

6.5 Group information 

Group information cannot be exported from the Revit software and ‘round tripping’ will not be possible if 
items are held within Groups. (This is due to a restriction within the Autodesk Revit API). 
 

 
   
Do not use groups when intending to round trip a model from Revit. 
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6.6 Worksharing and Worksets 

 
 
Tekla Structural Designer has no concept of worksharing or worksets therefore any collaboration 
information set within Revit will not be affected in any way. No workset or collaboration information will 
be written into the CXL format neutral file when exporting models to Tekla Structural Designer. 
All supported categories and instances held in worksets will be exported from Revit into Tekla Structural 
Designer. The collaboration information is not altered by any modifications performed in Tekla 
Structural Designer. When the model is returned to Revit, the workset information will still be unchanged. 
(If worksets have been updated in the time between the Export to Tekla Structural Designer and the 
returning information being merged in Revit, the workset change will also be kept.) 
However as Tekla Structural Designer has no information relating to the Revit collaboration commands, 
any new members created within Tekla Structural Designer will not have workset information defined. 
These members will be imported into the currently active workset. 
 
Please ensure that when merging models together in Revit that you have full access to all worksets. 
Please note that any locked worksets or borrowed elements cannot be updated. 
 

6.7 Pinning members 

The Pin command causes problems within Revit if you are trying to update the model with changes 
exported from Tekla Structural Designer. Items pinned are essentially locked in location and cannot be 
relocated or updated by any merge processes. 
 

 
 
Use the Pin command with care, and possibly not at all if integrating the model. It can prevent the correct 
updating of models. 
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6.8 Beam Systems 

 

 
 
Revit Structural Beam System instances have no equivalent object within Tekla Structural Designer 
and need to be handled with care. 
Although the beam system object itself will not be integrated, the beams held in the system are 
integrated. The beams will be exported as individual members.  
As long as the sections do not change, the beam system will be unaffected on returning results from 
Tekla Structural Designer back into Revit. 
 
However… 

 If one or more beams is changed in section size by the design process, the structural framing 
instance(s) will be similarly updated in section size on return to Revit. The altered instances will 
still be retained in the same beam system. 

 Any changes to the Beam Type parameter in the Structural Beam System instance will have no 
effect on the updated instance (it remains at the imported section size).  

 Any changes to the layout or justification parameters in the Structural Beam System may also 
adjust the position of the updated beam but the size cannot be affected. 

 
Changing any adjusted beam size to suit the same type reference as held in the Beam Type parameter 
will reset the instance. It will now alter to suit any changes made to the Beam Type parameter. 
 
The use of Structural Beam System Tags (Annotate → Beam System Symbol) will not show correct 
information where individual instances have been adjusted by the merge process.  
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6.9 Design Options 

The design option function in Revit allows you to explore different design options for various parts of your 
project. Design Options are parts of your model that are separated from the Main Model. The Revit user 
defines Option Sets, in which multiple Design Options can exist. Revit will only allow one of the Design 
Options from a set to be shown at any given time, so there is no duplicate geometry on any created 
view. 
 

 
 
Items held in design sets are still part of the main Revit file and will be exported to Tekla Structural 
Designer as default. 
This can easily lead to overlapping or collision of element errors occurring when the Tekla Structural 
Designer model is validated. 
 
To avoid these potential errors from occurring, we would advise that only one design option be 
integrated with the Tekla Structural Designer software. To do this, simply access a view showing un-
required design options and disable the Enable Analytical Model checkbox for all visible elements. 
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7 Appendix A: Creating tags to suit Tekla Structural 
Designer content. 

This section covers a number of examples of tags that can be created to show imported data from Tekla 
Structural Designer. The examples here are not exhaustive and you can use the information listed to 
generate tags to suit your own company standards. 
Please note that the following examples have been generated to suit a particular drawing style and may 
not meet the requirements of any particular company or standard. 
 

7.1 Creating a Structural Framing Tag to show End Forces 

This example will cover how to set up a Structural Framing Tag that can then be used to flag shear 
forces applied to the ends of the beam. We would usually recommend using a predefined Autodesk 
Structural Framing tag and alter this to suit. Suitable tags include:- 
 

 USA Imperial 
C:\ProgramData\Autodesk\RVT 20xx\Libraries\US Imperial\Annotations\Structural\Structural Framing Tag-w-
Start Reactions.rfa 

 UK 
C:\ProgramData\Autodesk\RVT 20xx\Libraries\UK\Annotations\Structural\Structural Framing Tag-w-Start 
Reactions.rfa 

 South East Asia 
C:\ProgramData\Autodesk\RVT 20xx\Libraries\South Asia\Annotations\Structural\Structural Framing Tag-w-
Start Reactions.rfa 

 
To begin, click on Open, browse to the correct path as shown above and open the file Structural 
Framing Tag-w-Start Reactions.rfa.  
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Firstly, click to select the contents of the current tag label, and then using the option Edit Label from the 
ribbon to alter the contents. 
 

 
     
Remove all of the current tag entries by selecting each one from the label parameters box and then 
using the Remove parameter from label option.  

 
Continue to perform this task until all 6 existing labels have been removed from the list of label 
parameters. 
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The parameters that we need to show within the tag are written into the family properties as a part of the 
integration process.  
Because of this, the labels do not exist within the default Revit parameters available to be included within 
a family. We will need to load in the parameters that we will need to use within the tag.  
Click Add Parameter to add in a new label entry. 
 

 
   
Adding a new parameter will access the Parameter Type dialog, click on the option to Select a shared 
parameter. 
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The next dialog Shared Parameters will show a list of all available parameters from the TSD Integrator 
Parameter Group.  
Click on the entry for Result_StartVShearMax to highlight and then click OK.  
 

 
   
Choose OK also on the Parameter Type dialog to return to the main Edit Label dialog. 
 
The parameter Result_StartVShearMax will now be shown in the list of available Category Parameters 
to the left hand side of the dialog. 
Highlight the parameter and then use the add button, (or simply double click on the name) to add the 
entry into the list of label parameters on the right hand side of the dialog.  
 

 
We will now add a prefix to the label parameter so that the overall tag will show the force title. The 
prefixes that we will use are as follows (suitable for EC3 member coordinate systems): 
 

• Label parameter: Result_StartVShearMax Prefix: FyMax =  
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Please note that the prefix should contain a trailing space character after the equals sign.  
Click OK when all data has been set-up to return to the main Revit screen. 

 
The style of the tag can be altered by again highlighting the label entry but this time using the Edit Type 
command that is held in the properties dialog. 
 

 
   
The dialog for the Type Properties will show the various settings governing the size, color and font of 
the tag itself. Any of these settings can be altered to suit your own company requirements. Make any 
changes required and then click OK when done. 
 
   
The Tag family can then be saved by using the Save As family option and choosing a suitable filename 
and location. We would recommend the use of prefixing all user created families with a company 
reference so that they can be easily differentiated from the default Autodesk content held in the model 
template. 
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7.1.1 Creating a similar tag for the end 2 reactions 

The created tag can also be modified and adjusted to suit a tag picking up on the shear force reported 
on the finish end of the member. Simply follow a similar process as before:- 

 
 Save As to create a copy of the existing tag. Provide a suitable name and choose a location to 

save the family to. 
 Edit the label contents; remove the existing Result_StartVShearMax parameter from the list. 
 Add a new parameter of Result_EndVShearMax and then host this new parameter into the 

Label Parameters window. 
 Add a suitable label prefix and then click OK to leave the dialog. 

 
The last alteration is to change the label location from the start of the member to the end of the member. 
To do this, click on the Family Category and Parameters command. 
 

 
 
Within this command, change the Attachment Point value from Start to be End. Click OK when done. 
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The second tag is now complete; you can Save all of your changes. Exit out of the family and return to 
your main model. 
The tags can be loaded into the model (or template) using the Load Family command (Insert tab) and 
then placed by using commands such as Tag by Category or Beam Annotations. 
 

7.1.2 Variations 

The preceding notes cover the creation of a tag showing the maximum Shear on member ends. For 
moment connections, you may wish to consider creating an additional tag family that contains Axial and 
Moment information. 
 
Parameters which you want to consider including may be Result_StartAxialMax, 
Result_StartMomentMax, Result_EndAxialMax and Result_EndMomentMax. 

 
The Break option on the right hand side of the dialog will split each of the parameters onto a separate 
line. If this is unticked then the parameters will all exist on the same line. Please take care of the tag 
width in this case though as truncation may occur if the width box is too small. 
 
The completed dialog for a moment connection end force tag may look similar to the following:- 

 

 
 
You may also want to consider creating tags which cover uplift (use result parameters with ...Neg 
suffixes) for both pinned and moment connections. The process is almost identical to as described 
previously apart from the different parameters and prefix information. 
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7.2 Creating Column Tags to indicate End Forces 

This example will cover how to set up a Structural Column Tag that can then be used to flag shear and 
moment forces applied to the base of the column.  
Please note that as there is no Structural Column tag similar to this already present within the AutoDesk 
Revit library we will show how to take an existing framing tag and alter this to suit. Suitable tags include 
:- 
 

 USA Imperial 
C:\ProgramData\Autodesk\RVT 20xx\Libraries\US Imperial\Annotations\Structural\Structural Framing Tag-w-
Start Reactions.rfa 

 UK 
C:\ProgramData\Autodesk\RVT 20xx\Libraries\UK\Annotations\Structural\Structural Framing Tag-w-Start 
Reactions.rfa 

 South East Asia 
C:\ProgramData\Autodesk\RVT 20xx\Libraries\South Asia\Annotations\Structural\Structural Framing Tag-w-
Start Reactions.rfa 

 
To begin, click on Open, browse to the correct path as shown above and open the file Structural 
Framing Tag-w-Start Reactions.rfa.  
 

 
   
After opening the correct Structural Framing tag family, the first task to achieve is to change the category 
so that the tag is applicable to Structural Columns. To do this access the command Family Category 
and Parameters. 
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Within the Family Category and Parameters dialog, click on Structural Column Tags to set the 
correct category and then click OK. 
 

 
 
The contents of the label can be altered, by firstly clicking to select the current tag label and then using 
the option Edit Label from the ribbon. 
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Remove all of the current tag entries by selecting each one from the label parameters box and then 
using the Remove parameter from label option. Continue to perform this task until all six existing labels 
have been removed from the list of label parameters. 
 

 
 
The parameters that we need to show within the tag are written into the family properties as a part of the 
integration process. Because of this, the labels do not exist within the default Revit parameters available 
to be included within a family. We will need to load in the parameters that we will need to use within the 
tag.  
Click Add Parameter to add in a new label entry. 
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Adding a new parameter will access the Parameter Parameters dialog, click on the option to Select a 
shared parameter. 
 

 
 
The next dialog Shared Parameters will show a list of all available parameters from the TSD Integrator 
parameter group. Click on the entry for Result_ColVShearMax to highlight and then click OK.  
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Choose OK also on the Parameter Properties dialog to return to the main Edit Label dialog. 
The parameter Result_ColVShearMax will now be shown in the list of available Category Parameters 
to the left hand side of the dialog. Highlight the parameter and then use the add button, (or simply 
double click on the name) to add the entry into the list of label parameters on the right hand side of the 
dialog. 
 

 
 
Repeat the previous steps so that 10 parameters are shown in the dialog: 

 Result_ColVShearMax 
 Result_ColVShearMin 
 Result_ColMajorShearMax 
 Result_ColMajorShearMin 
 Result_ColMinorShearMax 
 Result_ColMinorShearMin 
 Result_ColMajorMomentMax 
 Result_ColMajorMomentMin 
 Result_ColMinorMomentMax 
 Result_ColMinorMomentMin 

 
Please note that this will obviously create a label that contains 10 entries, some of which may not be 
used with any reasonable results. If you do not wish to have all of these entries, simply do not add the 
relevant parameter to the list. 
You may also wish to consider simply creating a schedule that references all of the column base forces; 
this will be covered in a separate section of these guidance notes. 
Add prefixes to each of the label parameters so that the overall tag will show the force titles. The prefixes 
that we have used are as follows (suitable for EC3 member coordinate systems):- 
 

 Label parameter: Result_ColVShearMax   Prefix: FvMax = 
 Label parameter: Result_ColVShearMin   Prefix: FvMin = 
 Label parameter: Result_ColMajorShearMax  Prefix: FyMax = 
 Label parameter: Result_ColMajorShearMin  Prefix: FyMin = 
 Label parameter: Result_ColMinorShearMax  Prefix: FzMax = 
 Label parameter: Result_ColMinorShearMin  Prefix: FzMin = 
 Label parameter: Result_ColMajorMomentMax  Prefix: MyMax = 
 Label parameter: Result_ColMajorMomentMin  Prefix: MyMin = 
 Label parameter: Result_ColMinorMomentMax  Prefix: MzMax = 
 Label parameter: Result_ColMinorMomentMin  Prefix: MzMin = 
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Please note that each prefix should contain a trailing space character after the equals sign. To ensure 
that each label is set on a separate line within the tag, please check the Break option to the right hand 
side of the Label Parameters window. 
 

 
 
Click OK, when all data has been set-up to return to the main Revit screen. 
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The style of the tag can be altered by again highlighting the label entry but this time using the Edit Type 
command that is held in the properties dialog. 
 

 
 
The dialog for the Type Properties will show the various settings governing the size, color and font of 
the tag itself. Any of these settings can be altered to suit your own company’s requirements. Make any 
changes required and then click OK when done. 
 
The Tag family can then be saved by using the Save As family option and choosing a suitable filename 
and location. We would recommend the use of prefixing all user created families with a company 
reference so that they can be easily differentiated from the default Autodesk content held in the model 
template. 
As the tag is now complete and saved, you can Exit out of the family and return to your main model. 
The tags can be loaded into the model (or template) using the Load Family command (Insert tab) and 
then placed by using commands such as Tag by Category or Tag All. 
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7.3 Creating a Structural Column Tag to show the Tekla Structural 
Designer part mark 

This example will cover how to set up a Structural Column tag that can then show the Tekla Structural 
Designer part mark in addition to the section size. Column tags that show the section size already exist 
within the default Autodesk Revit library so we will use one of these families and simply modify the 
contents. Suitable tags include:- 
 

 USA Imperial 
C:\ProgramData\Autodesk\RVT 20xx\Libraries\US Imperial\Annotations\Structural\Structural Column Tag.rfa 

 UK 
C:\ProgramData\Autodesk\RVT 20xx\Libraries\UK\Annotations\Structural\Anno_Structural_Column.rfa 

 South East Asia 
C:\ProgramData\Autodesk\RVT 20xx\Libraries\South Asia\Annotations\Structural\Structural Column Tag.rfa 

 
Please note the different filename for the UK content. 

 
To begin, click on Open, browse to the correct path as shown above and open the file Structural 
Column Tag.rfa or Anno_Structural_Column.rfa.  
 

 
   
Firstly, click to select the contents of the current tag label, and then using the option Edit Label from the 
ribbon to alter the contents. 
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Within the Edit Label dialog, we can see that there is an existing entry of Type Name already present. 
We will simply add the Tekla Structural Designer part mark parameter to this content so that the tag 
family contains two parameters. 
 
The parameter that we need to show within the tag is written into the family properties as a part of the 
integration process.  
Because of this, the specific parameter does not exist within the default Revit parameters available to be 
included within a family. We will need to load in the parameter required:  
Click Add Parameter to add in a new label entry. 
 

 
 
Adding a new parameter will access the Parameter Type dialog, click on the option to Select a shared 
parameter. 
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The next dialog Shared Parameters will show a list of all available parameters from the TSD Integrator 
Parameter Group.  
Click on the entry for TSDI_Part_Mark to highlight and then click OK.  
 

 
 
Choose OK also on the Parameter Type dialog to return to the main Edit Label dialog. 
 
The parameter TSDI_Part_Mark will now be shown in the list of available Category Parameters to the 
left hand side of the dialog. 
Highlight the parameter and then use the add button, (or simply double click on the name) to add the 
entry into the list of label parameters on the right hand side of the dialog. After adding the parameter it 
will be shown below the Type Name parameter, this can be adjusted using the Move parameter up 
option underneath the Label Parameters window. 
Selecting the option Break against the first line will ensure that the two parameters exist on separate 
lines in the family. 
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Click OK when all data has been set-up to return to the main Revit screen. As the width of the tag may 
be too small to fit the part mark or section size on one line without truncating the entry, click and drag 
either of the grip points to expand the box. 
 

 
  
The style of the tag can be altered by again highlighting the label entry but this time using the Edit Type 
command that is held in the properties dialog. 
 

 
 
The dialog for the Type Properties will show the various settings governing the size, color and font of 
the tag itself. Any of these settings can be altered to suit your own company requirements. Make any 
changes required and then click OK when done. 
   
The Tag family can then be saved by using the Save As family option and choosing a suitable filename 
and location. We would recommend the use of prefixing all user created families with a company 
reference so that they can be easily differentiated from the default Autodesk content held in the model 
template. 
As the tag is now complete and saved, you can Exit out of the family and return to your main model. 
The tags can be loaded into the model (or template) using the Load Family command (Insert tab) and 
then placed by using commands such as Tag by Category or Tag All. 
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7.3.1 Variations 

The preceding notes cover the creation of a tag for use on elevation and section views. For plan views, 
you may wish to use a family that is orientated at 45 degrees to the column location. 
The creation process is identical to previously described however we would recommend the use of a 
different base family. We would recommend the use of the family Structural Column Tag-45.rfa (for UK 
content use Anno_Tag_Structural_Column_45.rfa) and this should be found in the same directory 
location as the previously modified family. 
 

  



7 Appendix A: Creating tags to suit Tekla Structural Designer content. 120 (230) 

 

Guidance Notes Autodesk Revit Guidance 
© Trimble Solutions Corporation | December 5, 2019 Tekla Structural Designer Integrator 

 

7.4 Creating a Structural Framing Tag to show Composite Beam 
information 

This example will cover how to set up a Structural Framing Tag that can then be used to flag composite 
beam information that has been imported from Tekla Structural Designer 
We would recommend using a predefined Autodesk Structural Framing tag as a base point and then 
altering this to suit. Suitable tags include:- 
 

 USA Imperial 
C:\ProgramData\Autodesk\RVT 20xx\Libraries\US Imperial\Annotations\Structural\Structural Framing Tag.rfa 

 UK 
C:\ProgramData\Autodesk\RVT 20xx\Libraries\UK\Annotations\Structural\Anno_Tag_Structural_Framing.rfa 

 South East Asia 
C:\ProgramData\Autodesk\RVT 20xx\Libraries\South Asia\Annotations\Structural\Structural Framing Tag.rfa 

Please note the different filename for the UK content. 
 
To begin, click on Open, browse to the correct path as shown above and open either the file Structural 
Framing Tag.rfa or Anno_Tag_Structural_Framing.rfa.  
 

 
   
Firstly, click to select the contents of the current tag label, and then using the option Edit Label from the 
ribbon to alter the contents. 
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Within the Edit Label dialog, we can see that there is an existing entry of Type Name already present. 
We will simply add the additional Tekla Structural Designer parameters to this content so that the tag 
family contains the following references: 

 
 Part Mark 
 Type Name 
 Tekla Structural Designer Material Grade 
 Numbers of Studs (parenthesized) 
 Additional transverse reinforcement 

 
The Tekla Structural Designer parameters that we need to show within the tag are written into the family 
properties as a part of the integration process.  
Because of this, some of the specific parameters do not exist within the default Revit parameters 
available to be included within a family. We will need to load in the parameter required:  
Click Add Parameter to add in a new label entry. 
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Adding a new parameter will access the Parameter Type dialog, click on the option to Select a shared 
parameter. 
 

 
 
The next dialog Shared Parameters will show a list of all available parameters from the TSD Integrator 
Parameter Group.  
Click on the entry for TSDI_Part_Mark to highlight the entry and then click OK.  
 

 
   
Choose OK also on the Parameter Type dialog to return to the main Edit Label dialog. 
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The parameter TSDI_Part_Mark will now be shown in the list of available Category Parameters to the 
left hand side of the dialog. 
Highlight the parameter and then use the add button, (or simply double click on the name) to add the 
entry into the list of label parameters on the right hand side of the dialog.  
 

 
 
Repeat the previous steps so that five parameters are shown in the dialog: 

 Type Name 
o (Should already be present) 

 TSDI_Part_Mark 
 TSDI_Matl 
 Number of Studs 

o (This is a default Revit parameter and should already exist within the Category Parameters window) 

 TSDI_Trans_Reinf 

 
After adding the parameters, they will be shown in order of loading. Highlight particular lines, use the 
Move parameter up, and Move parameter down options to reorder the parameters as follows: 

 TSDI_Part_Mark 
 Type Name 
 TSDI_Matl 
 Number of Studs 
 TSDI_Trans_Reinf 
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Please also enable the Break option against the parameters TSDI_Part_Mark and Number of Studs to 
break the data into three separate lines. 
 

 
 
Add prefix and suffix information to help break up the data in the tag: 
 

 TSDI_Part_Mark :  Suffix of a single space character 
 TSDI_Matl :   Suffix of a single space character 
 Number of Studs:  Prefix of ( (open brackets character), suffix of ) (close brackets character) 

 
Click OK when all data has been set-up to return to the main Revit screen. As the width of the tag will be 
too small to fit all of the data without truncation occurring, click and drag either of the grip points to 
expand the box. 
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The lines that denote the width of the Boxed option of the tag may also be deleted if required. (NB: The 
Boxed option itself can be deleted by using the Family Types command if required) 
 

 
 
The style of the tag can be altered by highlighting the label entry but this time using the Edit Type 
command that is held in the properties dialog. 
 

 
   
The dialog for the Type Properties will show the various settings governing the size, color and font of 
the tag itself. Any of these settings can be altered to suit your own company requirements. Make any 
changes required and then click OK when done. 
 
 The Tag family can then be saved by using the Save As family option and choosing a suitable filename 
and location. We would recommend the use of prefixing all user created families with a company 
reference so that they can be easily differentiated from the default Autodesk content held in the model 
template. 
 
The tag can be loaded into the model (or template) using the Load Family command (Insert tab) and 
then placed by using commands such as Tag by Category or Beam Annotations. 
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7.4.1 Variations 

The preceding notes cover the creation of a tag showing a large amount of information within a single 
tag. It may be that two tags are preferred on plan drawings (one above the member and one below), if 
this is preferred simply follow the same guidance but create two separate tag families.  
One family would contain the part mark information whilst the other family contains the remainder of the 
information. These two tags can then be placed on drawing views using the Beam Annotations 
command or similar. 
For more general tags that simply show the Tekla Structural Designer part mark and the Type Name, 
follow the preceding notes but only include the parameters TSDI_Part_Mark and Type Name within the 
Label Parameters window. This style of tag may be suitable for steel bracing along with steel and 
concrete beams where more information can be shown in a schedule (see separate section on how to 
generate schedules containing Tekla Structural Designer information). 
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7.5 Creating a Wall tag indicating the Wall Name reference 

This example will cover how to set up a Wall tag that can then be used to show the Tekla Structural 
Designer Wall Name reference on drawing views. We would usually recommend using a predefined 
Autodesk Wall tag and alter this to suit. Suitable tags include:- 
 

 USA Imperial 
C:\ProgramData\Autodesk\RVT 2019\Libraries\US Imperial\Annotations\Architectural\Wall Tag.rfa 

 UK 
C:\ProgramData\Autodesk\RVT 2019\Libraries\UK\Annotations\Tags\Anno_Tag_Wall_Type_Mark.rfa 

 South East Asia 
C:\ProgramData\Autodesk\RVT 2019\Libraries\South Asia\Annotations\Architectural\Wall Tag.rfa 

Please note the different filename for the UK content. 
 
To begin, click on Open, browse to the correct path as shown above and open the file Wall Tag.rfa (or 
Anno_Tag_Wall_Type_Mark.rfa for UK content) 
 

 
   
Firstly, click to select the contents of the current tag label, and then using the option Edit Label from the 
ribbon to alter the contents. 
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Remove the existing Type Mark entry from the Label Parameters window by selecting the line and then 
using the Remove parameter from label option.  
 

 
 
The parameters that we need to show within the tag are written into the family properties as a part of the 
integration process.  
Because of this, the labels do not exist within the default Revit parameters available to be included within 
a family. We will need to load in the parameters that we will need to use within the tag.  
Click Add Parameter to add in a new label entry. 
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Adding a new parameter will access the Parameter Type dialog, click on the option to Select a shared 
parameter. 
 

 
 
The next dialog Shared Parameters will show a list of all available parameters from the TSD Integrator 
Parameter Group.  
Click on the entry for TSDI_Part_Mark to highlight and then click OK.  
 

 
   
Choose OK also on the Parameter Type dialog to return to the main Edit Label dialog. 
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The parameter TSDI_Part_Mark will now be shown in the list of available Category Parameters to the 
left hand side of the dialog. 
Highlight the parameter and then use the add button, (or simply double click on the name) to add the 
entry into the list of label parameters on the right hand side of the dialog.  
 

 
 
Click OK when all data has been set-up to return to the main Revit screen.  
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The style of the tag can be altered by again highlighting the label entry but this time using the Edit Type 
command that is held in the properties dialog. 
 

 
 
The dialog for the Type Properties will show the various settings governing the size, color and font of 
the tag itself. Any of these settings can be altered to suit your own company requirements. Make any 
changes required and then click OK when done. 
   
The Tag family can then be saved by using the Save As family option and choosing a suitable filename 
and location. We would recommend the use of prefixing all user created families with a company 
reference so that they can be easily differentiated from the default Autodesk content held in the model 
template. 
As the tag is now complete and saved, you can Exit out of the family and return to your main model. 
The tags can be loaded into the model (or template) using the Load Family command (Insert tab) and 
then placed by using commands such as Tag by Category or Tag All. 
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7.6 Creating a Floor tag which shows the Slab Name reference 

This example will cover how to set up a Floor tag that can then be used to show the Tekla Structural 
Designer Slab Name reference on drawing views. We would usually recommend using a predefined 
Autodesk Floor tag and alter this to suit. Suitable tags include:- 
 

 USA Imperial 
C:\ProgramData\Autodesk\RVT 2019\Libraries\US Imperial\Annotations\Architectural\Floor Tag.rfa 

 UK 
C:\ProgramData\Autodesk\RVT 2019\Libraries\UK\Annotations\Tags\Anno_Tag_Floor.rfa 

 South East Asia 
C:\ProgramData\Autodesk\RVT 2019\Libraries\South Asia\Annotations\Architectural\Floor Tag.rfa 

Please note the different filename for the UK content. 
 
To begin, click on Open, browse to the correct path as shown above and open the file Floor Tag.rfa (or 
Anno_Tag_Floor.rfa for UK content) 
 

 
   
Firstly, click to select the contents of the current tag label, and then using the option Edit Label from the 
ribbon to alter the contents. 
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Remove the existing Type Mark entry from the Label Parameters window by selecting the line and then 
using the Remove parameter from label option.  
 

 
 
The parameters that we need to show within the tag are written into the family properties as a part of the 
integration process.  
Because of this, the labels do not exist within the default Revit parameters available to be included within 
a family. We will need to load in the parameters that we will need to use within the tag.  
Click Add Parameter to add in a new label entry. 
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Adding a new parameter will access the Parameter Type dialog, click on the option to Select a shared 
parameter. 
 

 
 
The next dialog Shared Parameters will show a list of all available parameters from the TSD Integrator 
Parameter Group.  
Click on the entry for TSDI_Part_Mark to highlight and then click OK.  
 

 
   
Choose OK also on the Parameter Type dialog to return to the main Edit Label dialog. 
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The parameter TSDI_Part_Mark will now be shown in the list of available Category Parameters to the 
left hand side of the dialog. 
Highlight the parameter and then use the add button, (or simply double click on the name) to add the 
entry into the list of label parameters on the right hand side of the dialog.  
 

 
 
Click OK when all data has been set-up to return to the main Revit screen.  
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The style of the tag can be altered by again highlighting the label entry but this time using the Edit Type 
command that is held in the properties dialog. 
 

 
 
The dialog for the Type Properties will show the various settings governing the size, color and font of 
the tag itself. Any of these settings can be altered to suit your own company requirements. Make any 
changes required and then click OK when done. 
   
The Tag family can then be saved by using the Save As family option and choosing a suitable filename 
and location. We would recommend the use of prefixing all user created families with a company 
reference so that they can be easily differentiated from the default Autodesk content held in the model 
template. 
As the tag is now complete and saved, you can Exit out of the family and return to your main model. 
The tags can be loaded into the model (or template) using the Load Family command (Insert tab) and 
then placed by using commands such as Tag by Category or Tag All. 
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7.7 Setting tags as default within your company template 

After creating and saving a number of tags to suit the content imported from Tekla Structural Designer, 
you may want to load these into your active project, or into your company template for use on future 
projects. 
Loading the tag families can be performed using the Load Family command (held on the Insert tab). 
 

 
 
Once the tags have been loaded into the project or template, you can set the default tags to be used by 
clicking on the Loaded Tags and Symbols command (Tag submenu of the Annotate tab). 
 

 
 
Within the Loaded Tags and Symbols dialog, you can browse to each of the required lines and simply 
use the drop down available under the Loaded Tags option to flag your created tag family as being the 
default tag to be used. 
 

 
 
When you have set all of the information required, click OK to exit the dialog. 
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8 Appendix B: Creating Schedules to suit Tekla 
Structural Designer content. 

The following section covers how to generate schedules that then show information being populated 
from Tekla Structural Designer. There are a number of examples which follow but the basic principle of 
creating the schedule is very similar. 
The examples provided here are not exhaustive and you can use the information listed to generate 
schedules to suit your own company standards if required. 
Please note that the following examples have been generated to suit a particular drawing style and may 
not meet the requirements of any particular company or standard. 
 

8.1 Creating a Composite Floor Schedule 

From your open Revit project or template click on the View tab and then the command 
Schedule/Quantities (held in the Schedules sub-menu). 
 

 
 
After clicking on the command, you will be faced with a New Schedule dialog. Click to select Floors 
from the Category list and set the name as being TSD Composite Floor Schedule. Click OK after 
setting this data to access the main Schedule Properties dialog. 
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You should now be faced with a Schedule Properties dialog and be viewing the Fields tab. Within this 
tab, we can choose which parameters are going to be shown in the schedule. However, as many of the 
parameters we are wanting to use do not exist within the default Revit content, we will need to load these 
shared parameters into the schedule dialog so that they can then be hosted. 
 
To load a Tekla Structural Designer shared parameter into the schedule, click on the New Parameter 
command. 
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On the Parameter Properties dialog, choose to use a Shared Parameter and then click on Select. 
 

 
 
Select the shared parameter TSDI_Part_Mark (Parameter group: TSD Integrator) and then click OK to 
return to the Parameter Properties dialog. Click OK on the Parameters Properties dialog to return to 
the main Schedule Properties dialog. 
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With the TSDI_Part_Mark parameter now loaded into the schedule and listed in the Available Fields 
window, click to highlight and then use the Add parameter(s) command to place it into the Scheduled 
fields (in order) window. 
 

 
 
Repeat the same commands to add the following parameters in the following order:  
(NB. Positions of parameters can be adjusted by using the Move Parameter Up and Move Parameter Down commands held 
underneath the Scheduled fields… window). 
 

 TSDI_Part_Mark  : (TSD Integrator parameter group) 
 Elevation at Top  : (Revit parameter -  should already be available to select) 
 Level   : (Revit parameter -  should already be available to select) 
 Elevation at Bottom : (Revit parameter -  should already be available to select) 
 TSDI_Type   : (TSD Integrator parameter group) 

 
The next parameter to be included is the Thickness of the floor element. As this parameter is not 
available from either the default Revit content or the imported data from Tekla Structural Designer we will 
calculate the value. 
Click on the Add calculated parameter command. 
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Set the Calculated Value as following (keep values at default unless noted below): 
 Name : Thickness 
 Formula: Elevation at Top-Elevation at Bottom. 

o (NB: Using the ... button will allow the quick selection of the two Elevation parameters, rather than manually 
typing the name) 

 

 
 
Click OK when the information has been set up and it will then be added to the list of Scheduled fields. 
 
Complete the Scheduled fields window by adding another 5 parameters: 

 TSDI_Matl  : (TSD Integrator parameter group) 
 Volume  : (Revit parameter -  should already be available to select) 
 TSDI_Manufacturer : (TSD Integrator parameter group) 
 TSDI_Reference  : (TSD Integrator parameter group) 
 TSDI_Dim   : (TSD Integrator parameter group) 
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With the fields now set, we can set the filters so that only Composite Floor slabs are included in our 
schedule. Click on the Filter tab. 
 
Run through the dialog to set the following filters:- 

 Filter 1 
o Filter by : TSDI_Type 
o Action : equals 
o Search term : COMP_SLAB 

 

 
 
After generating the filters, click on the Sorting/Grouping tab so that we can sort the data into order. 
Apply the following actions: 

 Sort by : TSDI_Type 
o Ascending order 

 Then by : Level 
o Ascending order 

 Then by : TSDI_Part_Mark 
o Ascending order 
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Do not select the Grand totals option 
Keep the Itemize every instance option enabled. 
 

 
 
Access the Formatting tab and make the following changes:  
 

 TSDI_Part_Mark 
o Heading :   Part Mark 
o Alignment :   Center 

 Elevation at Top   
o Hidden Field:  Enabled 

 Level  
o Alignment :   Center 

 Elevation at Bottom  
o Hidden Field:  Enabled 

 TSDI_Type   
o Heading :   Slab Type 
o Alignment :   Center 

 Thickness 
o Alignment :   Center 

 TSDI_Matl  
o Heading :   Material 
o Alignment :   Center 

 Volume 
o Alignment :   Center 

 TSDI_Manufacturer 
o Heading :   Decking Manufacturer 
o Alignment :   Center 

 TSDI_RC_Cover  
o Heading :   Decking Profile 
o Alignment :   Center 

 TSDI_Dim  
o Heading :   Decking Gauge 
o Hidden Field:  Enabled 
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The final changes should be to the appearance of the schedule, setting the correct text font and line 
thicknesses. This should be done through the Appearance tab. 
Once you are happy with the contents and the format of the schedule, click OK. 
The schedule is now complete and can be hosted onto drawing views or exported to comma-separated-
file format. 
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8.2 Creating a Concrete Beam Schedule (English: United Kingdom 
option) 

(Please use these instructions if your Tekla Structural Designer software is set to use English: United Kingdom language format) 
From your open Revit project or template click on the View tab and then the command 
Schedule/Quantities (held in the Schedules sub-menu). 
 

 
 
After clicking on the command, you will be faced with a New Schedule dialog. Click to select Structural 
Framing from the Category list and set the name as being TSD Concrete Beam Schedule. Click OK 
after setting this data to access the main Schedule Properties dialog. 
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You should now be faced with a Schedule Properties dialog and be viewing the Fields tab. Within this 
tab, we can choose which parameters are going to be shown in the schedule. However, as many of the 
parameters we are wanting to use do not exist within the default Revit content, we will need to load these 
shared parameters into the schedule dialog so that they can then be hosted. 
 
To load a Tekla Structural Designer shared parameter into the schedule, click on the New Parameter 
command. 
 

 
 
On the Parameter Properties dialog, choose to use a Shared Parameter and then click on Select. 
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Select the shared parameter TSDI_Part_Mark (Parameter group: TSD Integrator) and then click OK to 
return to the Parameter Properties dialog. Click OK on the Parameters Properties dialog to return to 
the main Schedule Properties dialog. 
 

 
 
With the TSDI_Part_Mark parameter now loaded into the schedule and listed in the Available Fields 
window, click to highlight and then use the Add parameter(s) command to place it into the Scheduled 
fields (in order) window. 
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Repeat the same commands to add the following parameters in the following order:  
(NB. Positions of parameters can be adjusted by using the Move Parameter Up and Move Parameter Down commands held 
underneath the Scheduled fields… window). 
 

 TSDI_Part_Mark  : (TSD Integrator parameter group) 
 Type    : (Revit parameter -  should already be available to select) 
 TSDI_Matl   : (TSD Integrator parameter group) 
 Length   : (Revit parameter -  should already be available to select) 
 Cut Length   : (Revit parameter -  should already be available to select) 
 TSDI_Note   : (TSD Integrator parameter group) 
 TSDI_RC_Top   : (TSD RC Information parameter group) 
 TSDI_RC_Bottom   : (TSD RC Information parameter group) 
 TSDI_RC_Links   : (TSD RC Information parameter group) 
 TSDI_RC_Cover   : (TSD RC Information parameter group) 
 TSDI_Type   : (TSD Integrator parameter group) 

 
With the fields now set, we can set the filters so that only Concrete Beams are included in our schedule. 
Click on the Filter tab. 
 
Run through the dialog to set the following filters:- 

 Filter 1 
o Filter by : TSDI_Matl 
o Action : contains 
o Search term : C 

 Filter 2 
o Filter by : TSDI_Type 
o Action : does not contain 
o Search term : PILE 

 Filter 3 
o Filter by : TSDI_Matl 
o Action : does not contain 
o Search term : Tbr 

 Filter 4 
o Filter by : TSDI_Matl 
o Action : does not contain 
o Search term : A 
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After generating the filters, click on the Sorting/Grouping tab so that we can sort the data into order. 
Apply the following action: 

 Sort by : TSDI_Part_Mark 
o Ascending order 

 
Do not select the Grand totals option 
Keep the Itemize every instance option enabled. 
 

 
 
Access the Formatting tab and make the following changes:  
 

 TSDI_Part_Mark 
o Heading :  Part Mark 
o Alignment :  Center 

 Type   
o Heading :  Size 
o Alignment :  Center 

 TSDI_Matl   
o Heading :  Material 
o Alignment :  Center 

 Length  
o Alignment :  Center 

 Cut Length   
o Alignment :  Center 

 TSDI_Note  
o Heading :  Notes 
o Alignment :  Center 

 TSDI_RC_Top  
o Heading :  Rebar in Top 
o Alignment :  Center 

 TSDI_RC_Bottom 
o Heading :  Rebar in Bottom 
o Alignment :  Center 
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 TSDI_RC_Links 
o Heading :  Rebar Links 
o Alignment :  Center 

 TSDI_RC_Cover  
o Heading :  Designed Cover 
o Alignment :  Center 

 TSDI_Type  
o Hidden Field: Enabled 

 

 
 
The final changes should be to the appearance of the schedule, setting the correct text font and line 
thicknesses. This should be done through the Appearance tab. 
Once you are happy with the contents and the format of the schedule, click OK. 
The schedule is now complete and can be hosted onto drawing views or exported to comma-separated-
file format. 
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8.3 Creating a Concrete Beam Schedule (English: United States 
option) 

(Please use these instructions if your Tekla Structural Designer software is set to use English: United States language format) 
 
From your open Revit project or template click on the View tab and then the command 
Schedule/Quantities (held in the Schedules sub-menu). 
 

 
 
After clicking on the command, you will be faced with a New Schedule dialog. Click to select Structural 
Framing from the Category list and set the name as being TSD Concrete Beam Schedule. Click OK 
after setting this data to access the main Schedule Properties dialog. 
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You should now be faced with a Schedule Properties dialog and be viewing the Fields tab. Within this 
tab, we can choose which parameters are going to be shown in the schedule. However, as many of the 
parameters we are wanting to use do not exist within the default Revit content, we will need to load these 
shared parameters into the schedule dialog so that they can then be hosted. 
 
To load a Tekla Structural Designer shared parameter into the schedule, click on the New Parameter 
command. 
 

 
 
On the Parameter Properties dialog, choose to use a Shared Parameter and then click on Select. 
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Select the shared parameter TSDI_Part_Mark (Parameter group: TSD Integrator) and then click OK to 
return to the Parameter Properties dialog. Click OK on the Parameters Properties dialog to return to 
the main Schedule Properties dialog. 
 

 
 
With the TSDI_Part_Mark parameter now loaded into the schedule and listed in the Available Fields 
window, click to highlight and then use the Add parameter(s) command to place it into the Scheduled 
fields (in order) window. 
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Repeat the same commands to add the following parameters in the following order:  
(NB. Positions of parameters can be adjusted by using the Move Parameter Up and Move Parameter Down commands held 
underneath the Scheduled fields… window). 
 

 TSDI_Part_Mark  : (TSD Integrator parameter group) 
 Type    : (Revit parameter -  should already be available to select) 
 TSDI_Matl   : (TSD Integrator parameter group) 
 Length   : (Revit parameter -  should already be available to select) 
 Cut Length   : (Revit parameter -  should already be available to select) 
 TSDI_Note   : (TSD Integrator parameter group) 
 TSDI_RC_Top   : (TSD RC Information parameter group) 
 TSDI_RC_Bottom   : (TSD RC Information parameter group) 
 TSDI_RC_Stirrups  : (TSD RC Information parameter group) 
 TSDI_RC_Cover   : (TSD RC Information parameter group) 
 TSDI_Type   : (TSD Integrator parameter group) 

 
With the fields now set, we can set the filters so that only Concrete Beams are included in our schedule. 
Click on the Filter tab. 
 
Run through the dialog to set the following filters:- 

 Filter 1 
o Filter by : TSDI_Matl 
o Action : contains 
o Search term : C 

 Filter 2 
o Filter by : TSDI_Type 
o Action : does not contain 
o Search term : PILE 

 Filter 3 
o Filter by : TSDI_Matl 
o Action : does not contain 
o Search term : Tbr 

 Filter 4 
o Filter by : TSDI_Matl 
o Action : does not contain 
o Search term : A 
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After generating the filters, click on the Sorting/Grouping tab so that we can sort the data into order. 
Apply the following action: 

 Sort by : TSDI_Part_Mark 
o Ascending order 

 
Do not select the Grand totals option 
Keep the Itemize every instance option enabled. 
 

 
 
Access the Formatting tab and make the following changes:  
 

 TSDI_Part_Mark 
o Heading :  Part Mark 
o Alignment :  Center 

 Type   
o Heading :  Size 
o Alignment :  Center 

 TSDI_Matl   
o Heading :  Material 
o Alignment :  Center 

 Length  
o Alignment :  Center 

 Cut Length   
o Alignment :  Center 

 TSDI_Note  
o Heading :  Notes 
o Alignment :  Center 

 TSDI_RC_Top  
o Heading :  Rebar in Top 
o Alignment :  Center 

 TSDI_RC_Bottom 
o Heading :  Rebar in Bottom 
o Alignment :  Center 

 TSDI_RC_Stirrups 
o Heading :  Rebar Stirrups 
o Alignment :  Center 
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 TSDI_RC_Cover  
o Heading :  Designed Cover 
o Alignment :  Center 

 TSDI_Type  
o Hidden Field: Enabled 

 

 
 
The final changes should be to the appearance of the schedule, setting the correct text font and line 
thicknesses. This should be done through the Appearance tab. 
Once you are happy with the contents and the format of the schedule, click OK. 
The schedule is now complete and can be hosted onto drawing views or exported to comma-separated-
file format. 
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8.4 Creating a Concrete Column Schedule (English: United 
Kingdom option) 

(Please use these instructions if your Tekla Structural Designer software is set to use English: United Kingdom language format) 
 
From your open Revit project or template click on the View tab and then the command 
Schedule/Quantities (held in the Schedules sub-menu). 
 

 
 
After clicking on the command, you will be faced with a New Schedule dialog. Click to select Structural 
Columns from the Category list and set the name as being TSD Concrete Column Schedule. Click 
OK after setting this data to access the main Schedule Properties dialog. 
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You should now be faced with a Schedule Properties dialog and be viewing the Fields tab. Within this 
tab, we can choose which parameters are going to be shown in the schedule. However, as many of the 
parameters we are wanting to use do not exist within the default Revit content, we will need to load these 
shared parameters into the schedule dialog so that they can then be hosted. 
 
To load a Tekla Structural Designer shared parameter into the schedule, click on the New Parameter 
command. 
 

 
 
On the Parameter Properties dialog, choose to use a Shared Parameter and then click on Select. 
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Select the shared parameter TSDI_Part_Mark (Parameter group: TSD Integrator) and then click OK to 
return to the Parameter Properties dialog. Click OK on the Parameters Properties dialog to return to 
the main Schedule Properties dialog. 
 

 
 
With the TSDI_Part_Mark parameter now loaded into the schedule and listed in the Available Fields 
window, click to highlight and then use the Add parameter(s) command to place it into the Scheduled 
fields (in order) window. 
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Repeat the same commands to add the following parameters in the following order:  
(NB. Positions of parameters can be adjusted by using the Move Parameter Up and Move Parameter Down commands held 
underneath the Scheduled fields… window). 
 

 TSDI_Part_Mark : (TSD Integrator parameter group) 
 Type   : (Revit parameter -  should already be available to select) 
 TSDI_Matl  : (TSD Integrator parameter group) 
 Base Level : (Revit parameter -  should already be available to select) 
 Base Offset  : (Revit parameter -  should already be available to select) 
 Top Level : (Revit parameter -  should already be available to select) 
 Top Offset  : (Revit parameter -  should already be available to select) 
 Length : (Revit parameter -  should already be available to select) 
 TSDI_RC_Bars : (TSD RC Information parameter group) 
 TSDI_RC_Links  : (TSD RC Information parameter group) 
 TSDI_RC_Cover  : (TSD RC Information parameter group) 
 TSDI_Type  : (TSD Integrator parameter group) 

 
With the fields now set, we can set the filters so that only Concrete Columns are included in our 
schedule. Click on the Filter tab. 
 
Run through the dialog to set the following filters:- 

 Filter 1 
o Filter by : TSDI_Matl 
o Action : contains 
o Search term : C 

 Filter 2 
o Filter by : TSDI_Type 
o Action : does not contain 
o Search term : PILE 

 Filter 3 
o Filter by : TSDI_Matl 
o Action : does not contain 
o Search term : Tbr 

 Filter 4 
o Filter by : TSDI_Matl 
o Action : does not contain 
o Search term : A 

 



8 Appendix B: Creating Schedules to suit Tekla Structural Designer content. 163 (230) 

 

Guidance Notes Autodesk Revit Guidance 
© Trimble Solutions Corporation | December 5, 2019 Tekla Structural Designer Integrator 

 

 
 
After generating the filters, click on the Sorting/Grouping tab so that we can sort the data into order. 
Apply the following action: 

 Sort by : TSDI_Part_Mark 
o Ascending order 

 
Do not select the Grand totals option 
Keep the Itemize every instance option enabled. 
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Access the Formatting tab and make the following changes:  
 

 TSDI_Part_Mark 
o Heading :  Part Mark 
o Alignment :  Center 

 Type   
o Heading :  Size 
o Alignment :  Center 

 TSDI_Matl   
o Heading :  Material 
o Alignment :  Center 

 Base Level 
o Alignment :  Center 

 Base Offset   
o Alignment :  Center 

 Top Level 
o Alignment :  Center 

 Top Offset   
o Alignment :  Center 

 Length 
o Alignment :  Center 

 TSDI_Note  
o Heading :  Notes 
o Alignment :  Center 

 TSDI_RC_Bars  
o Heading :  Rebar  
o Alignment :  Center 

 TSDI_RC_Links 
o Heading :  Rebar Links 
o Alignment :  Center 

 TSDI_RC_Cover  
o Heading :  Designed Cover 
o Alignment :  Center 

 TSDI_Type  
o Hidden Field: Enabled 
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The final changes should be to the appearance of the schedule, setting the correct text font and line 
thicknesses. This should be done through the Appearance tab. 
Once you are happy with the contents and the format of the schedule, click OK. 
The schedule is now complete and can be hosted onto drawing views or exported to comma-separated-
file format. 
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8.5 Creating a Concrete Column Schedule (English: United States 
option) 

 
(Please use these instructions if your Tekla Structural Designer software is set to use English: United States language format) 
 
From your open Revit project or template click on the View tab and then the command 
Schedule/Quantities (held in the Schedules sub-menu). 
 

 
 
After clicking on the command, you will be faced with a New Schedule dialog. Click to select Structural 
Columns from the Category list and set the name as being TSD Concrete Column Schedule. Click 
OK after setting this data to access the main Schedule Properties dialog. 
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You should now be faced with a Schedule Properties dialog and be viewing the Fields tab. Within this 
tab, we can choose which parameters are going to be shown in the schedule. However, as many of the 
parameters we are wanting to use do not exist within the default Revit content, we will need to load these 
shared parameters into the schedule dialog so that they can then be hosted. 
 
To load a Tekla Structural Designer shared parameter into the schedule, click on the New Parameter 
command. 
 

 
 
On the Parameter Properties dialog, choose to use a Shared Parameter and then click on Select. 
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Select the shared parameter TSDI_Part_Mark (Parameter group: TSD Integrator) and then click OK to 
return to the Parameter Properties dialog. Click OK on the Parameters Properties dialog to return to 
the main Schedule Properties dialog. 
 

 
 
With the TSDI_Part_Mark parameter now loaded into the schedule and listed in the Available Fields 
window, click to highlight and then use the Add parameter(s) command to place it into the Scheduled 
fields (in order) window. 
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Repeat the same commands to add the following parameters in the following order:  

 
(NB. Positions of parameters can be adjusted by using the Move Parameter Up and Move Parameter Down commands held 
underneath the Scheduled fields… window). 
 

 TSDI_Part_Mark  : (TSD Integrator parameter group) 
 Type    : (Revit parameter -  should already be available to select) 
 TSDI_Matl   : (TSD Integrator parameter group) 
 Base Level  : (Revit parameter -  should already be available to select) 
 Base Offset   : (Revit parameter -  should already be available to select) 
 Top Level  : (Revit parameter -  should already be available to select) 
 Top Offset   : (Revit parameter -  should already be available to select) 
 Length  : (Revit parameter -  should already be available to select) 
 TSDI_RC_Bars  : (TSD RC Information parameter group) 
 TSDI_RC_Stirrups : (TSD RC Information parameter group) 
 TSDI_RC_Cover   : (TSD RC Information parameter group) 
 TSDI_Type   : (TSD Integrator parameter group) 

 
With the fields now set, we can set the filters so that only Concrete Columns are included in our 
schedule. Click on the Filter tab. 
 
Run through the dialog to set the following filters:- 

 Filter 1 
o Filter by : TSDI_Matl 
o Action : contains 
o Search term : C 

 Filter 2 
o Filter by : TSDI_Type 
o Action : does not contain 
o Search term : PILE 

 Filter 3 
o Filter by : TSDI_Matl 
o Action : does not contain 
o Search term : Tbr 

 Filter 4 
o Filter by : TSDI_Matl 
o Action : does not contain 
o Search term : A 
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After generating the filters, click on the Sorting/Grouping tab so that we can sort the data into order. 
Apply the following action: 

 Sort by : TSDI_Part_Mark 
o Ascending order 

 
Do not select the Grand totals option 
Keep the Itemize every instance option enabled. 
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Access the Formatting tab and make the following changes:  
 

 TSDI_Part_Mark 
o Heading :  Part Mark 
o Alignment :  Center 

 Type   
o Heading :  Size 
o Alignment :  Center 

 TSDI_Matl   
o Heading :  Material 
o Alignment :  Center 

 Base Level 
o Alignment :  Center 

 Base Offset   
o Alignment :  Center 

 Top Level 
o Alignment :  Center 

 Top Offset   
o Alignment :  Center 

 Length 
o Alignment :  Center 

 TSDI_Note  
o Heading :  Notes 
o Alignment :  Center 

 TSDI_RC_Bars  
o Heading :  Rebar  
o Alignment :  Center 

 TSDI_RC_Stirrups 
o Heading :  Rebar Stirrups 
o Alignment :  Center 

 TSDI_RC_Cover  
o Heading :  Designed Cover 
o Alignment :  Center 

 TSDI_Type  
o Hidden Field: Enabled 
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The final changes should be to the appearance of the schedule, setting the correct text font and line 
thicknesses. This should be done through the Appearance tab. 
Once you are happy with the contents and the format of the schedule, click OK. 
The schedule is now complete and can be hosted onto drawing views or exported to comma-separated-
file format. 
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8.6 Creating a (General) Floor Schedule 

From your open Revit project or template click on the View tab and then the command 
Schedule/Quantities (held in the Schedules sub-menu). 
 

 
 
After clicking on the command, you will be faced with a New Schedule dialog. Click to select Floors 
from the Category list and set the name as being TSD Floor Schedule. Click OK after setting this data 
to access the main Schedule Properties dialog. 
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You should now be faced with a Schedule Properties dialog and be viewing the Fields tab. Within this 
tab, we can choose which parameters are going to be shown in the schedule. However, as many of the 
parameters we are wanting to use do not exist within the default Revit content, we will need to load these 
shared parameters into the schedule dialog so that they can then be hosted. 
 
To load a Tekla Structural Designer shared parameter into the schedule, click on the New Parameter 
command. 
 

 
 
On the Parameter Properties dialog, choose to use a Shared Parameter and then click on Select. 
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Select the shared parameter TSDI_Part_Mark (Parameter group: TSD Integrator) and then click OK to 
return to the Parameter Properties dialog. Click OK on the Parameters Properties dialog to return to 
the main Schedule Properties dialog. 
 

 
 
With the TSDI_Part_Mark parameter now loaded into the schedule and listed in the Available Fields 
window, click to highlight and then use the Add parameter(s) command to place it into the Scheduled 
fields (in order) window. 
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Repeat the same commands to add the following parameters in the following order:  
 
(NB. Positions of parameters can be adjusted by using the Move Parameter Up and Move Parameter Down commands held 
underneath the Scheduled fields… window). 
 

 TSDI_Part_Mark  : (TSD Integrator parameter group) 
 Elevation at Top  : (Revit parameter -  should already be available to select) 
 Level   : (Revit parameter -  should already be available to select) 
 Elevation at Bottom : (Revit parameter -  should already be available to select) 
 TSDI_Type   : (TSD Integrator parameter group) 

 
The next parameter to be included is the Thickness of the floor element. As this parameter is not 
available from either the default Revit content or the imported data from Tekla Structural Designer we will 
calculate the value. 
Click on the Add calculated parameter command. 
 

 
 
Set the Calculated Value as following (keep values at default unless noted below): 

 Name : Thickness 
 Formula: Elevation at Top-Elevation at Bottom. 

o (NB: Using the ... button will allow the quick selection of the two Elevation parameters, rather than manually 
typing the name) 
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Click OK when the information has been set up and it will then be added to the list of Scheduled fields. 
 
Complete the Scheduled fields window by adding another 2 parameters: 

 TSDI_Matl  : (TSD Integrator parameter group) 
 Volume  : (Revit parameter -  should already be available to select) 

 

 
 
With the fields now set, we can set the filters so that only Floor slabs (and not Composite Floors) are 
included in our schedule. Click on the Filter tab. 
 
Run through the dialog to set the following filters:- 

 Filter 1 
o Filter by : TSDI_Type 
o Action : equals 
o Search term : SLAB 

 Filter 2 
o Filter by : TSDI_Type 
o Action : does not equal 
o Search term : COMP_SLAB 
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After generating the filters, click on the Sorting/Grouping tab so that we can sort the data into order. 
Apply the following actions: 

 Sort by : TSDI_Type 
o Ascending order 

 Then by : Level 
o Ascending order 

 Then by : TSDI_Part_Mark 
o Ascending order 

 
Do not select the Grand totals option 
Keep the Itemize every instance option enabled. 
 

 
 
Access the Formatting tab and make the following changes:  
 

 TSDI_Part_Mark 
o Heading :  Part Mark 
o Alignment :  Center 

 Elevation at Top   
o Hidden Field: Enabled 

 Level  
o Alignment :  Center 

 Elevation at Bottom  
o Hidden Field: Enabled 

 TSDI_Type   
o Heading :  Slab Type 
o Alignment :  Center 

 Thickness 
o Alignment :  Center 

 TSDI_Matl  
o Heading :  Material 
o Alignment :  Center 

 Volume 
o Alignment :  Center 
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The final changes should be to the appearance of the schedule, setting the correct text font and line 
thicknesses. This should be done through the Appearance tab. 
Once you are happy with the contents and the format of the schedule, click OK. 
The schedule is now complete and can be hosted onto drawing views or exported to comma-separated-
file format. 
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8.7 Creating a Foundation Schedule 

Foundations are imported into Revit from Tekla Structural Designer using Floor object elements. This is 
done to preserve the merge process whilst ensuring that changes to shape can be accommodated. For 
this reason, we will be creating our Foundation Schedule from a Floor Category. 
From your open Revit project or template click on the View tab and then the command 
Schedule/Quantities (held in the Schedules sub-menu). 
 

 
 
After clicking on the command, you will be faced with a New Schedule dialog. Click to select Floors 
from the Category list and set the name as being TSD Foundation Schedule. Click OK after setting 
this data to access the main Schedule Properties dialog. 
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You should now be faced with a Schedule Properties dialog and be viewing the Fields tab. Within this 
tab, we can choose which parameters are going to be shown in the schedule. However, as many of the 
parameters we are wanting to use do not exist within the default Revit content, we will need to load these 
shared parameters into the schedule dialog so that they can then be hosted. 
 
To load a Tekla Structural Designer shared parameter into the schedule, click on the New Parameter 
command. 
 

 
 
On the Parameter Properties dialog, choose to use a Shared Parameter and then click on Select. 
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Select the shared parameter TSDI_Part_Mark (Parameter group: TSD Integrator) and then click OK to 
return to the Parameter Properties dialog. Click OK on the Parameters Properties dialog to return to 
the main Schedule Properties dialog. 
 

 
 
With the TSDI_Part_Mark parameter now loaded into the schedule and listed in the Available Fields 
window, click to highlight and then use the Add parameter(s) command to place it into the Scheduled 
fields (in order) window. 
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Repeat the same commands to add the following parameters in the following order:  
 
(NB. Positions of parameters can be adjusted by using the Move Parameter Up and Move Parameter Down commands held 
underneath the Scheduled fields… window). 
 

 TSDI_Part_Mark  : (TSD Integrator parameter group) 
 Type   : (Revit parameter -  should already be available to select) 
 TSDI_Matl  : (TSD Integrator parameter group) 
 TSDI_Type  : (TSD Integrator parameter group) 
 Level   : (Revit parameter -  should already be available to select) 
 Elevation at Top  : (Revit parameter -  should already be available to select) 
 Elevation at Bottom : (Revit parameter -  should already be available to select) 

 
The next parameter to be included is the Thickness of the floor element. As this parameter is not 
available from either the default Revit content or the imported data from Tekla Structural Designer we will 
calculate the value. 

 
Click on the Add calculated parameter command. 
 

 
 
Set the Calculated Value as following (keep values at default unless noted below): 

 Name : Thickness 
 Formula: Elevation at Top-Elevation at Bottom. 

o (NB: Using the ... button will allow the quick selection of the two Elevation parameters, rather than manually 
typing the name) 
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Click OK when the information has been set up and it will then be added to the list of Scheduled fields. 
 
Complete the Scheduled fields window by adding one more parameter: 

 Volume  : (Revit parameter -  should already be available to select) 

 

 
 
With the fields now set, we can set the filters so that only Foundation items imported from Tekla 
Structural Designer are included in our schedule. Click on the Filter tab. 
 
Run through the dialog to set the following filters:- 

 Filter 1 
o Filter by : TSDI_Type 
o Action : does not contain 
o Search term : SLAB 
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After generating the filters, click on the Sorting/Grouping tab so that we can sort the data into order. 
Apply the following actions: 

 Sort by : TSDI_Type 
o Ascending order 

 Then by : Level 
o Ascending order 

 Then by : TSDI_Part_Mark 
o Ascending order 

 
Do not select the Grand totals option 
Keep the Itemize every instance option enabled. 
 

 
 
Access the Formatting tab and make the following changes:  
 

 TSDI_Part_Mark 
o Heading :  Part Mark 
o Alignment :  Center 

 Type  
o Alignment :  Center 

 TSDI_Matl   
o Heading :  Material 
o Alignment :  Center 

 TSDI_Type   
o Heading :  Foundation Type 
o Alignment :  Center 

 Level  
o Alignment :  Center 

 Elevation at Top   
o Hidden Field: Enabled 

 Elevation at Bottom  
o Hidden Field: Enabled 

 Thickness 
o Alignment :  Center 

 Volume 
o Alignment :  Center 
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The final changes should be to the appearance of the schedule, setting the correct text font and line 
thicknesses. This should be done through the Appearance tab. 
Once you are happy with the contents and the format of the schedule, click OK. 
The schedule is now complete and can be hosted onto drawing views or exported to comma-separated-
file format. 
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8.8 Creating a Pile Schedule 

Foundation piles are imported into Revit from Tekla Structural Designer using Structural Column object 
elements. This is done to preserve the merge process whilst ensuring that changes to shape can be 
accommodated. For this reason, we will be creating our Pile Schedule from a Structural Column 
Category. 

 
From your open Revit project or template click on the View tab and then the command 
Schedule/Quantities (held in the Schedules sub-menu). 
 

 
 
After clicking on the command, you will be faced with a New Schedule dialog. Click to select Structural 
Columns from the Category list and set the name as being TSD Pile Schedule. Click OK after setting 
this data to access the main Schedule Properties dialog. 
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You should now be faced with a Schedule Properties dialog and be viewing the Fields tab. Within this 
tab, we can choose which parameters are going to be shown in the schedule. However, as many of the 
parameters we are wanting to use do not exist within the default Revit content, we will need to load these 
shared parameters into the schedule dialog so that they can then be hosted. 
 
To load a Tekla Structural Designer shared parameter into the schedule, click on the New Parameter 
command. 
 

 
 
On the Parameter Properties dialog, choose to use a Shared Parameter and then click on Select. 
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Select the shared parameter TSDI_Part_Mark (Parameter group: TSD Integrator) and then click OK to 
return to the Parameter Properties dialog. Click OK on the Parameters Properties dialog to return to 
the main Schedule Properties dialog. 
 

 
 
With the TSDI_Part_Mark parameter now loaded into the schedule and listed in the Available Fields 
window, click to highlight and then use the Add parameter(s) command to place it into the Scheduled 
fields (in order) window. 
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Repeat the same commands to add the following parameters in the following order:  
 
(NB. Positions of parameters can be adjusted by using the Move Parameter Up and Move Parameter Down commands held 
underneath the Scheduled fields… window). 
 

 TSDI_Part_Mark : (TSD Integrator parameter group) 
 TSDI_Matl   : (TSD Integrator parameter group) 
 Type    : (Revit parameter -  should already be available to select) 
 Base Level  : (Revit parameter -  should already be available to select) 
 Base Offset   : (Revit parameter -  should already be available to select) 
 Top Level  : (Revit parameter -  should already be available to select) 
 Top Offset   : (Revit parameter -  should already be available to select) 
 Length  : (Revit parameter -  should already be available to select) 
 TSDI_Type   : (TSD Integrator parameter group) 

 
With the fields now set, we can set the filters so that only Tekla Structural Designer Pile objects are 
included in our schedule. Click on the Filter tab. 
 
Run through the dialog to set the following filters:- 

 Filter 1 
o Filter by : TSDI_Matl 
o Action : contains 
o Search term : C 

 Filter 2 
o Filter by : TSDI_Type 
o Action : contains 
o Search term : PILE 

 Filter 3 
o Filter by : TSDI_Matl 
o Action : does not contain 
o Search term : Conc 

 Filter 4 
o Filter by : TSDI_Matl 
o Action : does not contain 
o Search term : A 
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After generating the filters, click on the Sorting/Grouping tab so that we can sort the data into order. 
Apply the following action: 

 Sort by : TSDI_Part_Mark 
o Ascending order 

 
Do not select the Grand totals option 
Keep the Itemize every instance option enabled. 
 

 
 
Access the Formatting tab and make the following changes:  
 

 TSDI_Part_Mark 
o Heading :  Part Mark 
o Alignment :  Center 

 TSDI_Matl   
o Heading :  Material 
o Alignment :  Center 

 Type   
o Alignment :  Center 

 Base Level 
o Alignment :  Center 

 Base Offset   
o Alignment :  Center 

 Top Level 
o Alignment :  Center 

 Top Offset   
o Alignment :  Center 

 Length 
o Alignment :  Center 

 TSDI_Type  
o Hidden Field: Enabled 
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The final changes should be to the appearance of the schedule, setting the correct text font and line 
thicknesses. This should be done through the Appearance tab. 
Once you are happy with the contents and the format of the schedule, click OK. 
The schedule is now complete and can be hosted onto drawing views or exported to comma-separated-
file format. 
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8.9 Creating a Steel Beam End Forces Schedule 

From your open Revit project or template click on the View tab and then the command 
Schedule/Quantities (held in the Schedules sub-menu). 
 

 
 
After clicking on the command, you will be faced with a New Schedule dialog. Click to select Structural 
Framing from the Category list and set the name as being TSD Steel Beam End Forces Schedule. 
Click OK after setting this data to access the main Schedule Properties dialog. 
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You should now be faced with a Schedule Properties dialog and be viewing the Fields tab. Within this 
tab, we can choose which parameters are going to be shown in the schedule. However, as many of the 
parameters we are wanting to use do not exist within the default Revit content, we will need to load these 
shared parameters into the schedule dialog so that they can then be hosted. 
 
To load a Tekla Structural Designer shared parameter into the schedule, click on the New Parameter 
command. 
 

 
 
On the Parameter Properties dialog, choose to use a Shared Parameter and then click on Select. 
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Select the shared parameter TSDI_Part_Mark (Parameter group: TSD Integrator) and then click OK to 
return to the Parameter Properties dialog. Click OK on the Parameters Properties dialog to return to 
the main Schedule Properties dialog. 
 

 
 
With the TSDI_Part_Mark parameter now loaded into the schedule and listed in the Available Fields 
window, click to highlight and then use the Add parameter(s) command to place it into the Scheduled 
fields (in order) window. 
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Repeat the same commands to add the following parameters in the following order:  
(NB. Positions of parameters can be adjusted by using the Move Parameter Up and Move Parameter Down commands held 
underneath the Scheduled fields… window). 
 

 TSDI_Part_Mark  : (TSD Integrator parameter group) 
 Type    : (Revit parameter -  should already be available to select) 
 TSDI_Matl   : (TSD Integrator parameter group) 
 TSDI_StartConn  : (TSD Integrator parameter group) 
 Result_StartVShearMax  : (TSD Integrator  parameter group) 
 Result_StartVShearMaxNeg  : (TSD Integrator  parameter group) 
 Result_StartAxialMax  : (TSD Integrator  parameter group) 
 Result_StartAxialMaxNeg  : (TSD Integrator  parameter group) 
 Result_StartMomentMax  : (TSD Integrator  parameter group) 
 Result_StartMomentMaxNeg  : (TSD Integrator  parameter group) 
 TSDI_EndConn  : (TSD Integrator parameter group) 
 Result_EndVShearMax  : (TSD Integrator  parameter group) 
 Result_EndVShearMaxNeg : (TSD Integrator  parameter group) 
 Result_EndAxialMax  : (TSD Integrator  parameter group) 
 Result_EndAxialMaxNeg  : (TSD Integrator  parameter group) 
 Result_EndMomentMax  : (TSD Integrator  parameter group) 
 Result_EndMomentMaxNeg  : (TSD Integrator  parameter group) 
 TSDI_Type   : (TSD Integrator parameter group) 
 TSDI_Detail_Grp  : (TSD Integrator parameter group) 

 
With the fields now set, we can set the filters so that only Concrete Beams are included in our schedule. 
Click on the Filter tab. 
 
Run through the dialog to set the following filters:- 

 Filter 1 
o Filter by : TSDI_Detail_Grp 
o Action : does not contain 
o Search term : <empty cell> 

 Filter 2 
o Filter by : TSDI_Type 
o Action : does not equal 
o Search term : BRACE 

 Filter 3 
o Filter by : TSDI_Type 
o Action : does not contain 
o Search term : Truss 
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After generating the filters, click on the Sorting/Grouping tab so that we can sort the data into order. 
Apply the following action: 

 Sort by : TSDI_Part_Mark 
o Ascending order 

 
Do not select the Grand totals option 
Keep the Itemize every instance option enabled. 
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Access the Formatting tab and make the following changes:  
 

 TSDI_Part_Mark 
o Heading :  Part Mark 
o Alignment :  Center 

 Type   
o Heading :  Section Size 
o Alignment :  Center 

 TSDI_Matl   
o Heading :  Material 
o Alignment :  Center 

 TSDI_StartConn   
o Heading :  Start Conn 
o Alignment :  Center 

 Result_StartVShearMax   
o Heading :  Start Vert Shear Max 
o Alignment :  Center 

 Result_StartVShearMaxNeg   
o Heading :  Start Vert Shear Neg 
o Alignment :  Center 

 Result_StartAxialMax   
o Heading :  Start Axial Max 
o Alignment :  Center 

 Result_StartAxialMaxNeg   
o Heading :  Start Axial Neg 
o Alignment :  Center 

 Result_StartMomentMax   
o Heading :  Start Mom Max 
o Alignment :  Center 

 Result_StartMomentMaxNeg   
o Heading :  Start Mom Neg 
o Alignment :  Center 

 TSDI_EndConn   
o Heading :  End Conn 
o Alignment :  Center 

 Result_EndVShearMax   
o Heading :  End Vert Shear Max 
o Alignment :  Center 

 Result_EndVShearMaxNeg   
o Heading :  End Vert Shear Neg 
o Alignment :  Center 

 Result_EndAxialMax   
o Heading :  End Axial Max 
o Alignment :  Center 

 Result_EndAxialMaxNeg   
o Heading :  End Axial Neg 
o Alignment :  Center 

 Result_EndMomentMax   
o Heading :  End Mom Max 
o Alignment :  Center 

 Result_EndMomentMaxNeg   
o Heading :  End Mom Neg 
o Alignment :  Center 

 TSDI_Type  
o Hidden Field: Enabled 

 TSDI_Detail_Grp  
o Hidden Field: Enabled 
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The final changes should be to the appearance of the schedule, setting the correct text font and line 
thicknesses. This should be done through the Appearance tab. 
Once you are happy with the contents and the format of the schedule, click OK. 
The schedule is now complete and can be hosted onto drawing views or exported to comma-separated-
file format. 
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8.10 Creating a Steel Beam Schedule 

From your open Revit project or template click on the View tab and then the command 
Schedule/Quantities (held in the Schedules sub-menu). 
 

 
 
After clicking on the command, you will be faced with a New Schedule dialog. Click to select Structural 
Framing from the Category list and set the name as being TSD Steel Beam Schedule. Click OK after 
setting this data to access the main Schedule Properties dialog. 
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You should now be faced with a Schedule Properties dialog and be viewing the Fields tab. Within this 
tab, we can choose which parameters are going to be shown in the schedule. However, as many of the 
parameters we are wanting to use do not exist within the default Revit content, we will need to load these 
shared parameters into the schedule dialog so that they can then be hosted. 
 
Before we load the Tekla Structural Designer shared parameters into the dialog, we will add two of the 
default Revit parameters into the Scheduled Fields window. 
Click to highlight the entry Count from the Available Fields window, click on Add parameter(s) and it 
will move the entry across to the Scheduled Fields window. 
 

 
 
Repeat the same process with the Revit parameter Type. 
To load a Tekla Structural Designer shared parameter into the schedule, click on the New Parameter 
command. 
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On the Parameter Properties dialog, choose to use a Shared Parameter and then click on Select. 
 

 
 
Select the shared parameter TSDI_Matl (Parameter group: TSD Integrator) and then click OK to return 
to the Parameter Properties dialog. Click OK on the Parameters Properties dialog to return to the 
main Schedule Properties dialog. 
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The TSDI_Matl parameter can now be added into the Scheduled fields (in order) window as per the 
previous two entries. 
Repeat the same commands to add the following parameters in the following order:  
(NB. Positions of parameters can be adjusted by using the Move Parameter Up and Move Parameter Down commands held 
underneath the Scheduled fields… window). 
 

 Count  : (Revit parameter -  should already be available to select) 
 Type   : (Revit parameter -  should already be available to select) 
 TSDI_Matl  : (TSD Integrator parameter group) 
 TSDI_Type  : (TSD Integrator parameter group) 
 TSDI_Trans_Reinf : (TSD Integrator parameter group) 
 Length   : (Revit parameter -  should already be available to select) 
 TSDI_Detail_Grp  : (TSD Integrator parameter group) 

 
With the fields now set, we can set the filters so that only Steel Beams are included in our schedule. 
Click on the Filter tab. 
 
Run through the dialog to set the following filters:- 

 Filter 1 
o Filter by : TSDI_Detail_Grp 
o Action : does not contain 
o Search term : <blank cell> 

 Filter 2 
o Filter by : TSDI_Type 
o Action : does not equal 
o Search term : BRACE 
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After generating the filters, click on the Sorting/Grouping tab so that we can sort the data into order. 
Apply the following actions: 

 Sort by : TSDI_Type 
o Ascending order 

 Sort by : Type 
o Ascending order 

 Sort by : Length 
o Ascending order 

 Sort by : TSDI_Matl 
o Ascending order 

 

Ensure the Grand totals is enabled (Title, count, and totals option) 
Deselect the Itemize every instance option. 
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Access the Formatting tab and make the following changes:  
 

 Count 
o Alignment :  Center 

 Type   
o Heading :  Section Size 
o Alignment :  Center 

 TSDI_Matl   
o Heading :  Material 
o Alignment :  Center 

 TSDI_Type  
o Heading :  Beam Type 
o Alignment :  Center 

 TSDI_Trans_Reinf  
o Heading :  Additional Transverse Reinforc. 
o Alignment :  Center 

 Length  
o Alignment :  Center 

 TSDI_Detail_Grp  
o Hidden Field: Enabled 

 

 
 
The final changes should be to the appearance of the schedule, setting the correct text font and line 
thicknesses. This should be done through the Appearance tab. 
Once you are happy with the contents and the format of the schedule, click OK. 
The schedule is now complete and can be hosted onto drawing views or exported to comma-separated-
file format. 
 

  



8 Appendix B: Creating Schedules to suit Tekla Structural Designer content. 206 (230) 

 

Guidance Notes Autodesk Revit Guidance 
© Trimble Solutions Corporation | December 5, 2019 Tekla Structural Designer Integrator 

 

8.11 Creating a Steel Brace Schedule 

From your open Revit project or template click on the View tab and then the command 
Schedule/Quantities (held in the Schedules sub-menu). 
 

 
 
After clicking on the command, you will be faced with a New Schedule dialog. Click to select Structural 
Framing from the Category list and set the name as being TSD Steel Brace Schedule. Click OK after 
setting this data to access the main Schedule Properties dialog. 
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You should now be faced with a Schedule Properties dialog and be viewing the Fields tab. Within this 
tab, we can choose which parameters are going to be shown in the schedule. However, as many of the 
parameters we are wanting to use do not exist within the default Revit content, we will need to load these 
shared parameters into the schedule dialog so that they can then be hosted. 
 
To load a Tekla Structural Designer shared parameter into the schedule, click on the New Parameter 
command. 
 

 
 
On the Parameter Properties dialog, choose to use a Shared Parameter and then click on Select. 
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Select the shared parameter TSDI_Part_Mark (Parameter group: TSD Integrator) and then click OK to 
return to the Parameter Properties dialog. Click OK on the Parameters Properties dialog to return to 
the main Schedule Properties dialog. 
 

 
 
With the TSDI_Part_Mark parameter now loaded into the schedule and listed in the Available Fields 
window, click to highlight and then use the Add parameter(s) command to place it into the Scheduled 
fields (in order) window. 
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Repeat the same commands to add the following parameters in the following order:  
 
(NB. Positions of parameters can be adjusted by using the Move Parameter Up and Move Parameter Down commands held 
underneath the Scheduled fields… window). 
 

 TSDI_Part_Mark : (TSD Integrator parameter group) 
 Type   : (Revit parameter -  should already be available to select) 
 TSDI_Matl  : (TSD Integrator parameter group) 
 Length  : (Revit parameter -  should already be available to select) 
 Result_AxialMax  : (TSD Integrator parameter group) 
 TSDI_Type  : (TSD Integrator parameter group) 
 TSDI_Detail_Grp  : (TSD Integrator parameter group) 

 
With the fields now set, we can set the filters so that only Steel Bracing members are included in our 
schedule. Click on the Filter tab. 
 
Run through the dialog to set the following filters:- 

 Filter 1 
o Filter by : TSDI_Detail_Grp 
o Action : does not contain 
o Search term : <blank cell> 

 Filter 2 
o Filter by : TSDI_Type 
o Action : equals 
o Search term : BRACE 
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After generating the filters, click on the Sorting/Grouping tab so that we can sort the data into order. 
Apply the following action: 

 Sort by : TSDI_Part_Mark 
o Ascending order 

 
Do not select the Grand totals option 
Keep the Itemize every instance option enabled. 
 

 
 
Access the Formatting tab and make the following changes:  
 

 TSDI_Part_Mark 
o Heading :  Part Mark 
o Alignment :  Center 

 Type   
o Heading :  Section Size 
o Alignment :  Center 

 TSDI_Matl   
o Heading :  Material 
o Alignment :  Center 

 Length  
o Alignment :  Center 

 Result_AxialMax  
o Heading :  Axial Max 
o Alignment :  Center 

 TSDI_Type  
o Hidden Field: Enabled 

 TSDI_Detail_Grp  
o Hidden Field: Enabled 
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The final changes should be to the appearance of the schedule, setting the correct text font and line 
thicknesses. This should be done through the Appearance tab. 
Once you are happy with the contents and the format of the schedule, click OK. 
The schedule is now complete and can be hosted onto drawing views or exported to comma-separated-
file format. 
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8.12 Creating a Steel Column Base Forces Schedule 

From your open Revit project or template click on the View tab and then the command 
Schedule/Quantities (held in the Schedules sub-menu). 
 

 
 
After clicking on the command, you will be faced with a New Schedule dialog. Click to select Structural 
Columns from the Category list and set the name as being TSD Steel Column Base Forces 
Schedule. Click OK after setting this data to access the main Schedule Properties dialog. 
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You should now be faced with a Schedule Properties dialog and be viewing the Fields tab. Within this 
tab, we can choose which parameters are going to be shown in the schedule. However, as many of the 
parameters we are wanting to use do not exist within the default Revit content, we will need to load these 
shared parameters into the schedule dialog so that they can then be hosted. 
 
To load a Tekla Structural Designer shared parameter into the schedule, click on the New Parameter 
command. 
 

 
 
On the Parameter Properties dialog, choose to use a Shared Parameter and then click on Select. 
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Select the shared parameter TSDI_Part_Mark (Parameter group: TSD Integrator) and then click OK to 
return to the Parameter Properties dialog. Click OK on the Parameters Properties dialog to return to 
the main Schedule Properties dialog. 
 

 
 
With the TSDI_Part_Mark parameter now loaded into the schedule and listed in the Available Fields 
window, click to highlight and then use the Add parameter(s) command to place it into the Scheduled 
fields (in order) window. 
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Repeat the same commands to add the following parameters in the following order:  
 
(NB. Positions of parameters can be adjusted by using the Move Parameter Up and Move Parameter Down commands held 
underneath the Scheduled fields… window). 
 

 TSDI_Part_Mark  : (TSD Integrator parameter group) 
 Type    : (Revit parameter -  should already be available to select) 
 Result_ColMajorMomentMax : (TSD Integrator parameter group) 
 Result_ColMajorMomentMin : (TSD Integrator parameter group) 
 Result_ColMajorShearMax : (TSD Integrator parameter group) 
 Result_ColMajorShearMin : (TSD Integrator parameter group) 
 Result_ColMinorMomentMax : (TSD Integrator parameter group) 
 Result_ColMinorMomentMin : (TSD Integrator parameter group) 
 Result_ColMinorShearMax : (TSD Integrator parameter group) 
 Result_ColMinorShearMin : (TSD Integrator parameter group) 
 Result_ColVShearMax : (TSD Integrator parameter group) 
 Result_ColVShearMin : (TSD Integrator parameter group) 
 TSDI_Matl   : (TSD Integrator parameter group) 
 TSDI_Detail_Grp   : (TSD Integrator parameter group) 

 
With the fields now set, we can set the filters so that only Steel Columns are included in our schedule. 
Click on the Filter tab. 
 
Run through the dialog to set the following filters:- 

 Filter 1 
o Filter by : TSDI_Detail_Grp 
o Action : does not contain 
o Search term : <blank cell> 

 Filter 2 
o Filter by : Result_ColVShearMax 
o Action : is greater than 
o Search term : 0.22 kip (1.00 kN for metric templates) 

 

 
 
  



8 Appendix B: Creating Schedules to suit Tekla Structural Designer content. 216 (230) 

 

Guidance Notes Autodesk Revit Guidance 
© Trimble Solutions Corporation | December 5, 2019 Tekla Structural Designer Integrator 

 

After generating the filters, click on the Sorting/Grouping tab so that we can sort the data into order. 
Apply the following action: 

 Sort by : TSDI_Part_Mark 
o Ascending order 

 
Do not select the Grand totals option 
Keep the Itemize every instance option enabled. 
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Access the Formatting tab and make the following changes:  
 

 TSDI_Part_Mark 
o Heading :  Part Mark 
o Alignment :  Center 

 Type   
o Heading :  Section Size 
o Alignment :  Center 

 Result_ColMajorMomentMax  
o Heading :  Max Major Moment 
o Alignment :  Center 

 Result_ColMajorMomentMin  
o Heading :  Min Major Moment 
o Alignment :  Center 

 Result_ColMajorShearMax  
o Heading :  Max Major Shear 
o Alignment :  Center 

 Result_ColMajorShearMin  
o Heading :  Min Major Shear 
o Alignment :  Center 

 Result_ColMinorMomentMax  
o Heading :  Max Minor Moment 
o Alignment :  Center 

 Result_ColMinorMomentMin  
o Heading :  Min Minor Moment 
o Alignment :  Center 

 Result_ColMinorShearMax  
o Heading :  Max Minor Shear 
o Alignment :  Center 

 Result_ColMinorShearMin  
o Heading :  Min Minor Shear 
o Alignment :  Center 

 Result_ColVShearMax  
o Heading :  Max Axial 
o Alignment :  Center 

 Result_ColVShearMin  
o Heading :  Min Axial 
o Alignment :  Center 

 TSDI_Matl  
o Hidden Field: Enabled 

 TSDI_Detail_Grp 
o Hidden Field: Enabled 
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The final changes should be to the appearance of the schedule, setting the correct text font and line 
thicknesses. This should be done through the Appearance tab. 
Once you are happy with the contents and the format of the schedule, click OK. 
The schedule is now complete and can be hosted onto drawing views or exported to comma-separated-
file format. 
 

8.12.1 Variants 

This schedule will include all columns including upper stacks of spliced columns, columns sat directly 
onto supporting beams and truss vertical struts. 
 
Additional filters can be added to help reduce the amount of information: 

 Ensuring that parameter: TSDI_Part_Mark, action: contains, search term: SC will remove Truss 
Struts from the list.  

 Similarly adding a filter that parameter: TSDI_Part_Mark, action: contains, search term: -1 will 
ensure that upper stacks of splice columns are omitted from the schedule.  

 Alternatively a filter of parameter: TSDI_Part_Mark, action: does not contain, search term: -1 
will ensure that only upper stacks of splice columns are included in the schedule. 

 
Additional schedules can also be created using these or similar filters. 
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8.13 Creating a Steel Column Schedule 

From your open Revit project or template click on the View tab and then the command 
Schedule/Quantities (held in the Schedules sub-menu). 
 

 
 
After clicking on the command, you will be faced with a New Schedule dialog. Click to select Structural 
Columns from the Category list and set the name as being TSD Steel Column Schedule. Click OK 
after setting this data to access the main Schedule Properties dialog. 
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You should now be faced with a Schedule Properties dialog and be viewing the Fields tab. Within this 
tab, we can choose which parameters are going to be shown in the schedule. However, as many of the 
parameters we are wanting to use do not exist within the default Revit content, we will need to load these 
shared parameters into the schedule dialog so that they can then be hosted. 
 
To load a Tekla Structural Designer shared parameter into the schedule, click on the New Parameter 
command. 
 

 
 
On the Parameter Properties dialog, choose to use a Shared Parameter and then click on Select. 
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Select the shared parameter TSDI_Part_Mark (Parameter group: TSD Integrator) and then click OK to 
return to the Parameter Properties dialog. Click OK on the Parameters Properties dialog to return to 
the main Schedule Properties dialog. 
 

 
 
With the TSDI_Part_Mark parameter now loaded into the schedule and listed in the Available Fields 
window, click to highlight and then use the Add parameter(s) command to place it into the Scheduled 
fields (in order) window. 
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Repeat the same commands to add the following parameters in the following order:  
 
(NB. Positions of parameters can be adjusted by using the Move Parameter Up and Move Parameter Down commands held 
underneath the Scheduled fields… window). 
 

 TSDI_Part_Mark : (TSD Integrator parameter group) 
 Type   : (Revit parameter -  should already be available to select) 
 TSDI_Matl : (TSD Integrator parameter group) 
 TSDI_Type : (TSD Integrator parameter group) 
 Base Level : (Revit parameter -  should already be available to select) 
 Base Offset : (Revit parameter -  should already be available to select) 
 Top Level : (Revit parameter -  should already be available to select) 
 Top Offset : (Revit parameter -  should already be available to select) 
 Length : (Revit parameter -  should already be available to select) 
 TSDI_Detail_Grp  : (TSD Integrator parameter group) 

 
With the fields now set, we can set the filters so that only Steel Columns are included in our schedule. 
Click on the Filter tab. 
 
Run through the dialog to set the following filters:- 

 Filter 1 
o Filter by : TSDI_Detail_Grp 
o Action : does not contain 
o Search term : <blank cell> 

 Filter 2 
o Filter by : TSDI_Type 
o Action : does not contain 
o Search term : PILE 

 

 
 
  



8 Appendix B: Creating Schedules to suit Tekla Structural Designer content. 223 (230) 

 

Guidance Notes Autodesk Revit Guidance 
© Trimble Solutions Corporation | December 5, 2019 Tekla Structural Designer Integrator 

 

After generating the filters, click on the Sorting/Grouping tab so that we can sort the data into order. 
Apply the following action: 

 Sort by : TSDI_Part_Mark 
o Ascending order 

 
Enable the Grand totals option. Use the Title, count, and totals default filter 
Keep the Itemize every instance option enabled. 
 

 
 
Access the Formatting tab and make the following changes:  
 

 TSDI_Part_Mark 
o Heading :  Part Mark 
o Alignment :  Center 

 Type   
o Heading :  Section Size 
o Alignment :  Center 

 TSDI_Matl  
o Heading :  Material 
o Alignment :  Center 

 TSDI_Type  
o Heading :  Column Type 
o Alignment :  Center 

 Base Level  
o Alignment :  Center 

 Base Offset  
o Alignment :  Center 

 Top Level  
o Alignment :  Center 

 Top Offset  
o Alignment :  Center 

 Length  
o Alignment :  Center 

 TSDI_Detail_Grp 
o Hidden Field: Enabled 
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The final changes should be to the appearance of the schedule, setting the correct text font and line 
thicknesses. This should be done through the Appearance tab. 
Once you are happy with the contents and the format of the schedule, click OK. 
The schedule is now complete and can be hosted onto drawing views or exported to comma-separated-
file format. 
 

8.13.1 Variants 

This schedule will include all columns including upper stacks of spliced columns, columns sat directly 
onto supporting beams and truss vertical struts. 
 
Additional filters can be added to help reduce the amount of information: 

 Ensuring that parameter: TSDI_Part_Mark, action: contains, search term: SC will remove Truss 
Struts from the list.  

 Similarly adding a filter that parameter: TSDI_Part_Mark, action: contains, search term: -1 will 
ensure that upper stacks of splice columns are omitted from the schedule.  

 Alternatively a filter of parameter: TSDI_Part_Mark, action: does not contain, search term: -1 
will ensure that only upper stacks of splice columns are included in the schedule. 

 
Additional schedules can also be created using these or similar filters. 
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8.14 Creating a Wall Schedule 

From your open Revit project or template click on the View tab and then the command 
Schedule/Quantities (held in the Schedules sub-menu). 
 

 
 
After clicking on the command, you will be faced with a New Schedule dialog. Click to select Walls from 
the Category list and set the name as being TSD Wall Schedule. Click OK after setting this data to 
access the main Schedule Properties dialog. 
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You should now be faced with a Schedule Properties dialog and be viewing the Fields tab. Within this 
tab, we can choose which parameters are going to be shown in the schedule. However, as many of the 
parameters we are wanting to use do not exist within the default Revit content, we will need to load these 
shared parameters into the schedule dialog so that they can then be hosted. 
 
To load a Tekla Structural Designer shared parameter into the schedule, click on the New Parameter 
command. 
 

 
 
On the Parameter Properties dialog, choose to use a Shared Parameter and then click on Select. 
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Select the shared parameter TSDI_Part_Mark (Parameter group: TSD Integrator) and then click OK to 
return to the Parameter Properties dialog. Click OK on the Parameters Properties dialog to return to 
the main Schedule Properties dialog. 
 

 
 
With the TSDI_Part_Mark parameter now loaded into the schedule and listed in the Available Fields 
window, click to highlight and then use the Add parameter(s) command to place it into the Scheduled 
fields (in order) window. 
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Repeat the same commands to add the following parameters in the following order:  
(NB. Positions of parameters can be adjusted by using the Move Parameter Up and Move Parameter Down commands held 
underneath the Scheduled fields… window). 
 

 TSDI_Part_Mark  : (TSD Integrator parameter group) 
 Type   : (Revit parameter -  should already be available to select) 
 TSDI_Matl  : (TSD Integrator parameter group) 
 TSDI_Type  : (TSD Integrator parameter group) 
 Width  : (Revit parameter -  should already be available to select) 
 Level   : (Revit parameter -  should already be available to select) 
 Base Constraint  : (Revit parameter -  should already be available to select) 
 Base Offset  : (Revit parameter -  should already be available to select) 
 Top Constraint  : (Revit parameter -  should already be available to select) 
 Top Offset  : (Revit parameter -  should already be available to select) 
 Unconnected Height : (Revit parameter -  should already be available to select) 
 Volume  : (Revit parameter -  should already be available to select) 

 
With this particular schedule, there are no additional filters to set. We can therefore bypass the Filter 
tab. 
 
After generating the filters, click on the Sorting/Grouping tab so that we can sort the data into order. 
Apply the following actions: 

 Sort by : TSDI_Type 
o Ascending order 

 Then by : TSDI_Part_Mark 
o Ascending order 

 
Do not select the Grand totals option 
Keep the Itemize every instance option enabled. 
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Access the Formatting tab and make the following changes:  
 

 TSDI_Part_Mark 
o Heading :  Part Mark 
o Alignment :  Center 

 Type  
o Alignment :  Center 

 TSDI_Matl   
o Heading :  Material 
o Alignment :  Center 

 TSDI_Type   
o Heading :  Wall Type 
o Alignment :  Center 

 Width  
o Alignment :  Center 

 Length  
o Alignment :  Center 

 Base Constraint  
o Alignment :  Center 

 Base Offset  
o Alignment :  Center 

 Top Constraint  
o Alignment :  Center 

 Top Offset  
o Alignment :  Center 

 Unconnected Height  
o Alignment :  Center 

 Volume  
o Alignment :  Center 

 

 
 
The final changes should be to the appearance of the schedule, setting the correct text font and line 
thicknesses. This should be done through the Appearance tab. 
Once you are happy with the contents and the format of the schedule, click OK. 
The schedule is now complete and can be hosted onto drawing views or exported to comma-separated-
file format. 
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8.15 Creating additional schedules to filter contents by floor level 

Within Revit, it is possible to create additional schedules that allow data to be filtered by floor. In this 
way, you are able to create schedules for (say) Concrete Beams on first floor, Concrete Beams on 
second floor etc. 
To generate additional schedules, right click on the name and then use the command Duplicate View 
and the sub-command Duplicate. 
 

 
 
The Revit parameter Level will need to be added to the list on Scheduled Fields. You will then need to 
add a Filter that uses the Level filter against a specific level. It is also possible to filter schedule data by 
the parameter TSD_Part_Mark as, by default; this will be set to reference the beam level within the part 
mark entry. 
The Level parameter can be omitted from the schedule by accessing the Formatting tab and enabling 
the option Hidden Field. 
 


